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1 General Information

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This operating manual serves as an aid for the installation and operation of the product and
supports the technical staff with all operating and maintenance tasks to be performed.
Furthermore, this manual is aimed at preventing dangers to life and health of the user and third
parties.

1.2 Who Is this Operating Manual Targeted To?

The operating manual provides a code of conduct for personnel tasked with the setup, operation,
maintenance, and repair of gas engines. A certain level of technical knowledge with respect to the
operation of gas engines and basic knowledge of electronic ignition systems are necessary.
Persons who are only authorized to operate the gas engine shall be trained by the operating
company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary action steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE

Notice

. This symbol indicates important notices for the user. Follow these. In

1 addition, this symbol is used for overviews that give you a summary of the
necessary work steps.

NOTICE

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.

Rev. 01/2026 7



1 General Information

Danger

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned
precautionary measures.

DANGER

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?

In the operating manual or the user interface, the following abbreviations/acronyms are used.

Abb. Term

ADV Advance

ASO Auxiliary
Synchronization Output

ATDC After Top Dead Center

BTDC Before Top Dead
Center

CAN bus Controller Area
Network bus

CE Conformité Européenne

CPU Central Processing Unit

°crankshaft Degree crankshaft

CSA Canadian Standards
Association

DC Direct Current

DetCon Detonation Control
System

EMI Electromagnetic
Interference

EMC Electromagnetic
Compatibility

GPI General Purpose Input

8

Description

Advanced with respect
to top dead center

Bus for control
devices/networks

Conformity with EU
legislation

Multi-purpose input

Explanation
Indicates the direction for timing

Output for synchronizing the
MIC3+ and other controllers

Asynchronous serial connection
system for linking control units

Marking based on EU legislation
for certain products in conjunction
with product safety

Unit for the rotation angle of the
crankshaft

Organization that defines
standards, inspects products for
safety compliance, and issues
pertinent certifications.

Serves to prevent serious engine
damage caused by knocking
combustion.

Compatibility of electrical or
electronic equipment items with
their environment

Rev. 01/2026



1 General Information

Abb.
GPO

HV

ISO

LED

MIC

MICT

MOSFET

PG

POT

PWR
RET

RS485/
TIA485

TDC
usB

Rev. 01/2026

Term Description

General Purpose Multi-purpose output
Output

High voltage

International
Organization for
Standardization

Light Emitting Diode

MOTORTECH Ignition
Controller
MOTORTECH
Integrated
Configuration Tool
Metal Oxide

Semiconductor Field-
Effect Transistor

Panzergewinde Panzer Screw Thread

Potentiometer

Power Output/current
Retard Retarded with respect

to the top dead center
Recommended

Standard 485/
Telecommunications
Industry Association
485

Top Dead Center

Universal Serial Bus

Explanation

Light emitting electronic
semiconductor

Software for the configuration of
the MIC3+

Semiconductor component

Screw thread type for cable screw
connections

Continuously adjustable potential
divider

Indicates the direction for timing

Industrial standard for a physical
interface for asynchronous serial
data transfer

Serial connection system to link a
computer to external devices



2 Safety Instructions

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, there is danger to life through high voltage
particularly in the area of the ignition system. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

Ignition coils and caps
— Wires of the high voltage circuit
— In- and output wiring of the ignition controller
— Pickups and their wiring

Danger to persons with implanted cardiac devices!

Electromagnetic impulses in the wiring of the ignition system may exceed
the permissible limits of active implanted cardiac devices such as
pacemakers or defibrillators. Persons with cardiac devices must
DANGER therefore not be present in the vicinity of the ignition system being
operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless, the equipment can cause risks or damage can occur if the following
instructions are not complied with:

The gas engine must only be operated by trained and authorized personnel.

Observe all safety instructions of the system and all safety instructions of the system
operator.

Operate the equipment only within the parameters specified in the technical data.
Use the equipment correctly and for its intended use only.
Never apply force.

For all work such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

Perform only such maintenance and repair work as is described in the operating manual, and
follow the instructions given while working.

Only use spare parts supplied by MOTORTECH for the maintenance of the equipment.

Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance will void any guarantee for the proper functioning of the equipment as well as the
responsibility for the validity of the certifications.

Safety devices must not be dismounted or disabled.

Avoid all activities that can impair the function of the equipment.
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2 Safety Instructions

— Operate the equipment only while it is in proper condition.
— Investigate all changes detected while operating the gas engine or ignition system.

— Ensure compliance with all laws, directives, and regulations applicable to the operation of
your system, including such not expressly stated herein.

— If the gas-carrying parts of the system are not entirely sealed, gas may escape and result in
explosion hazard. The inhalation of gas can also lead to death or severe health damage.
Therefore, upon completion of all assembly works, always check the system's tightness.

— Always ensure adequate ventilation of the engine compartment.
— Ensure a safe position at the gas engine.

— Thereis arisk of burning on hot surfaces. Allow the gas engine to cool down before starting
any work.

— Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all
work on the gas engine.

— Noise from the system can cause permanent or temporary damage to your hearing. Wear
suitable hearing protection at the system.

— Your behavior can reduce possible residual risks to a minimum. Observe responsible handling
of the gas engine and the gas-carrying system.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

— Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

— Do not wear clothing made from synthetic materials to prevent static electricity from building
up on your body. Your clothing should therefore be made of cotton or cotton blend materials.

— Keep plastics such as vinyl and Styrofoam materials as far away from the equipment and the
work environment as possible.

— Do not remove the circuit boards from the housing of the equipment.

2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

— Electromagnetic interferences (e.g. ground loops)

— Signal corruption (e.g. of the analog voltage signal)

— Unwanted leakage currents

In the entire electrical system, the earth potential and the negative pole of the power supply
should therefore be connected separately from each other for all devices where this is possible. If

possible, the negative pole of the power supply should only be connected to earth potential at one
point in the entire system.

Rev. 01/2026 n



2 Safety Instructions

Wiring Example
Device with Device with
shielded wires protection class Il

sl LE

ny
”§

L+

24VDC

Occurrence of ground loops

i The devices shown in the following image do not offer the option of

connecting the earth potential and the negative pole of the power supply
separately from each other. This results in a ground loop.

NOTICE

A ground loop is a closed loop connection in electrical cabling or wiring
that causes an unwanted voltage drop in the signal path due to the
impedance (resistance R > 0) of the loop when low-frequency
interference currents (l) are present.

Device 1 Device 2

(D Ol
1

|
I____+ _________________ -

Ground loop
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2 Safety Instructions

2.4 Special Safety Instructions for the Device

DANGER

Rev. 01/2026

Danger to life! Hazardous residual voltage!

After stopping the ignition, there is dangerous residual voltage for up to
three minutes in the ignition system. Do not touch any components of the
ignition kit during this time.

Explosion hazard!

If the system is located in a potentially explosive atmosphere, never open
the device (e.g. by opening the service screw or removing covers). There
is arisk of explosion.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T4.

Explosion hazard!

Do not disconnect any connectors while the system is live. If the system
is located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Never remove the equipment while the unit is connected to a power
source. If the system is located in a hazardous area, there is a risk of
explosion.



2 Safety Instructions

Explosion hazard!
Do not remove or replace the fuse while the equipment is live.

Risk of burning!

The surfaces of the system may heat up to high temperatures.

Operational safety!

All connector screws and screw joints must be adequately tightened.
Refer to the section Mechanical Data on page 17.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it
is in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated,
maintaining the indicated protection classes, as well as compliance with
CSA-Class I, Division 2 (Group C, D) is impaired.

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC4. Therefore, pay attention to the following when welding:

— Disconnect all electrical connections to the MIC4 prior to welding.

— Protect the MIC4 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

Rev. 01/2026



2 Safety Instructions

Danger of interference with radio reception!

The device is not intended for use in residential areas and cannot ensure
adequate protection of radio reception in such environments.

2.5 CSA-Relevant Safety Instructions

English warning notice

WARNING - EXPLOSION
HAZARD - Substitution of
components may impair
suitability for Class |,
Division 2.

WARNING — EXPLOSION
HAZARD! Do not
disconnect while circuit is
live unless area is known
to be non-hazardous.

2.6 Proper Disposal

French warning notice

AVERTISSEMENT - RISQUE
D'EXPLOSION - La substitution
de composants peut rendre ce
materiel inacceptable pour les
emplacements de Classe |,
Division 2.

AVERTISSEMENT - RISQUE
D'EXPLOSION! Ne pas
débrancher tant que le circuit est
sous tension, a moins qu'il ne
s'agisse d'un emplacement non
dangereux.

German translation

WARNUNG - EXPLOSIONS-
GEFAHR! — Der Austausch von
Bauteilen oder Baugruppen
kann die Eignung fur die CSA-
Class I, Division 2 beeintrach-
tigen.

WARNUNG - EXPLOSIONS-
GEFAHR! Keine Verbindungen
I6sen, solange der Stromkreis
aktiv ist, auBer das Umfeld wird
als nicht explosionsgeféhrdet
eingestuft.

For the proper disposal of MOTORTECH equipment, observe the information provided at
www.motortech.de. In this context, please also note that the BR2450A/GA industrial battery,
which is permanently built into the mainboard of the ignition controller, contains lithium.
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3 Intended Use

3.1 Functional Description

The devices of the MIC4 series are microprocessor controlled ignition systems, that are
comprised of one 32 bit main processor (CPU) and an output board.

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent configuration.
The ignition controllers of the MIC4 series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The timing is influenced by various inputs
made either automatically or manually. This can be implemented with manual potentiometers, the
analog input signals, a speed characteristic, or with a serial interface (USB, CAN bus, RS485).
During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected computer.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-off.

3.2 Applications

Danger of interference with radio reception!

The device is not intended for use in residential areas and cannot ensure
adequate protection of radio reception in such environments.

The ignition controllers of the MIC4 series are designed for specific 2- or 4-stroke gas engines.
From 1to max. 16 ignition outputs are available.The ignition controllers supply the energy required
for the corresponding ignition coils of the gas engines and can supply signals for peripheral
equipment.

As per EN 55011, the MIC4 ignition controller are equipment of Group 1and Class A.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of any guarantee.

16 Rev. 01/2026



4 Product Description

4.1 Technical Data

4.1.1 Certifications

The ignition controllers of the MIC4 series are certified as follows: CE, CSA
The Panel Mount Version fulfils the CSA directives if it is installed in a correspondingly certified
control cabinet.

The EU Declaration of Conformity and the CSA certificate of your MIC4 can be obtained on
request from your MOTORTECH contact person (see section Customer Service Information on
page 160).

4.1.2 Mechanical Data
The MIC4 has the following mechanical characteristics.
Feature Value

Dimensions Panel Mount Version:
282.1mm x 206.7 mm x 64.6 mm (11.11" x 8.14" x 2.54")
(length x width x height)

Light Duty Version:
305 mm x 240 mm x 98.7 mm (12.02" x 9.45" x 3.89")
(length x width x height)

Heavy Duty Version:
305 mm x 240 mm x 115.2 mm (12.02" x 9.45" x 4.54")
(length x width x height)

Weight Panel Mount Version:
5.2 kg (1.5 Ibs)

Light Duty Version:
3.9kg (8.51bs)

Heavy Duty Version:
6.7 kg (14.8 Ibs)

Shape of device See chapter Overview Drawings on page 25

Rev. 01/2026



4 Product Description

Feature

Mechanical environmental
conditions

Standard single seal inserts for
PG screw joints (Heavy Duty
and Light Duty Version)

Multiple seal inserts for PG
screw joints (Heavy Duty and
Light Duty Version)

Climatic environmental
conditions

Value

The housing is resistant to general atmospheric
contaminations.
Resistant to gas engine oils.

Panel Mount Version:
Protection class: |, Protection: IP20

Light Duty Version:
Protection class: |, Protection: IP69

Heavy Duty Version:
Protection class: |, Protection: IP69

The specified protection classes and types are only
guaranteed if all external wiring connections are made in
accordance with the connector specification, all covers and
seals are installed as intended and the following tightening
torques are observed:

— AllM4 bolts: 0.8 Nm to 1Nm (0.6 Ib-ft to 0.7 Ib-ft)
— PG screw joints: 4.5 Nmto 5 Nm (3.3 Ib-ft to 3.6 Ib-ft)
— Service screw: 2.5 Nm to 3 Nm (1.9 Ib-ft to 2.2 Ib-ft)

Always use a new seal when installing the service cover.

Suitable for a cable with a diameter of 6 mm to 13 mm.

Suitable for up to three cables, each with a diameter of 6 mm
to 7 mm.

Panel Mount Version:
—20 °C to +50 °C (-4 °F to +122 °F)

Light Duty Version:

—40 °C to +60 °C (-40 °F to +140 °F)

Heavy Duty Version*:

—40 °C to +70 °C (-40 °F to +158 °F)

Max. 85 % humidity without condensation up to 3,000 m
(9,842'") above sea level

Determining Maximum Ambient Temperature for Heavy Duty Version
* The maximum ambient temperature for the Heavy Duty Version of the MIC4 is dependent on the
net power delivered. This can be up to +80 °C (+176 °F) for low net power.

Net power Max. ambient temperature
18 W +80 °C (+176 °F)
36 W +75 °C (+167 °F)
54 W +70 °C (+158 °F)
18 Rev. 01/2026



4 Product Description

Determine the maximum ambient temperature for the Heavy Duty Version of the MIC4 as follows:

1. Determine the net power (P) delivered.

Engine type Max. ambient temperature

Two-Stroke Engine ) 4
b Number of Revolutions [min™"] x Energy [J] x Number of Outputs

60

Four-Stroke Engine P
. Number of Revolutions [min™'] x Energy [J] “ Number of Outputs

60 2

Notice:
Energy refers to the set energy limit (see Timing — Schedule A/B — Energy on page 103). The
number of outputs refers to the configured outputs.

2. Calculate the maximum ambient temperature.

Max. ambient temperature in°C=80 - (P - 18) x 5 /18
The formula is defined for P 2 18 W. The ambient temperature is therefore limited to
+80 °C (+176 °F).

Rev. 01/2026



4 Product Description

4.1.3 Warning Notices on the Device

Validity of warning notices on device
[ ]

1 components connected to it.

NOTICE

English warning notice on French warning notice on the
the device device

WARNING! Read and ATTENTION! Lisez et comprenez
understand the installation le manuel d’installation et

and operating manual prior d’utilisation avant d’installer ou
to installing or making any  d’effectuer une modification.
adjustments.

WARNING — EXPLOSION AVERTISSEMENT - RISQUE
HAZARD! Do not D'EXPLOSION! Ne pas
disconnect while circuitis  débrancher tant que le circuit est
live unless area is known sous tension, a moins qu'il ne
to be non-hazardous. For  s'agisse d'un emplacement non
wiring details refer to dangereux. Pour plus de détails
operating manual. de cablage, veuillez consulter le
manuel d’utilisation.

CAUTION! Do not pressure  ATTENTION! Ne pas laver cette

wash this device. Damage  boite de contréle en utilisant un

to electronic components  jet sous pression. Cela pourrait

may result. endommager les composants
électroniques.

Warning Symbol on Device

Warning of hot surface

20

The warning notices on the device are valid for the MIC4 and all

German translation

WARNUNG! Lesen und ver-
stehen Sie die Installations-
und Betriebsanleitung vor der
Installation und bevor Ein-
stellungen vorgenommen
werden.

EXPLOSIONSGEFAHR! Keine
Verbindungen I6sen, solange
der Stromkreis aktiv ist, auRBer
das Umfeld wird als nicht
explosionsgeféhrdet einge-
stuft. Hinweise zur Ver-
kabelung finden Sie in der
Betriebsanleitung.

ACHTUNG! Das Gerat nicht mit
Hochdruck reinigen. Es kénnte
zu Schaden an den elektro-
nischen Bauteilen fihren.
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4 Product Description

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

— Part number of the ignition controller (P/N)

— Arrangement number of the ignition controller (A/N)

— Serial number of the ignition controller (S/N)

= MOTORTECH

www.motortech.de

| P/N 66.00.410-16 }

c € |A/N  422.16.C000-000-AA-0 |

|S/N 01008066

4.1.5 Electrical Data

The MIC4 has the following electrical characteristics.

Feature
Power consumption

Power supply

Required current

Number of outputs

Firing angle

Rev. 01/2026

Value
max. 100 W at 24 V

Nominal voltage: 24 V DC
Operating voltage: 10 VDC to 32 V DC

Max. current 7 A. An estimation of the power requirements can
be found after this table.

8,12 or 16 outputs

The size of the firing angle depends on the max. overspeed.
The smallest firing angle per output bank can be calculated
using the following formula:

. Overspeed [minh
Ignition Angle = T X 360°x1.7ms

21



4 Product Description

Feature

Ignition frequency

Value

With full energy output (all 16 ignition outputs with 300 mJ), an
ignition frequency of 250 Hz as continuous load is possible.
With less ignition energy or in case of a brief overload, 333 Hz
is possible. The maximum output load of 75 W must not be
exceeded.

2-stroke engine:

0 d[min”!
Ignition Fequency = %[mm]x Number of Ignition Outputs

4-stroke engine:

" 1 Overspeed [min'1] =
Ignition Fequency = 5% — x Number of Ignition Outputs

Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rpom and 300 mJ energy.

Outputs Voltage
8 24V
12 24V
16 24V

Required current Voltage Required current
23A 12V ** 46A

3.3A 12V ** 6.4 A

43A 12V ** 6.8A*

* Ignition energy is limited to 250 mJ.

** Nominal voltage 24 V DC

Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs
Analog current input

Analog voltage input
Auxiliary analog input supply

voltage

Binary input (Start/Stop)

22

Values

Current range: 0 mA to 20 mA (adjustable in MICT)
Input impedance: 27 Q || 1 yF

Voltage range: 0 mA to 10 mA (adjustable in MICT)
Input impedance: 12.4 kQ || 200 nF

5V to 24V /50 mA depending on the configuration in the MICT
Wiring
Input current: max. 20 mA

Ignition stop: 0 V to 0.8 V (low level)
Ignition release: 2.8 V to 32 V (high level)
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4 Product Description

Inputs and outputs

Binary input (schedule A/B)

Binary input (GPI, general
purpose input)

Go/NoGo and GPO outputs

Signal LED
ASO output

Pickup input

Ignition coil outputs

Rev. 01/2026

Values
Wiring
Input current: max. 20 mA

Schedule A: 0 V10 0.8 V (low level)
Schedule B: 2.8 V to 32 V (high level)

Wiring
Input current: max. 20 mA

Low level: 0 Vto 0.8V
High level: 2.8 Vto 32 V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 109)

One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MOSFET relay

Maximum switching voltage: 32 V DC

Peak/steady current: max. 100 mA DC

Output power: max. 2.5 W

Internal resistance: 58 Q to 60 Q

Activation delay: 0.5 ms/100 mA load max.

Deactivation delay: 0.2 ms / max. 100 mA load

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.

Six LEDs are used as status indicators.

TTL level (5 V)
max. current: + 10 mA

Impedance: 10 kQ

The voltage supply for active pickup can be set using the MICT
from5Vto24V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC4 may not have a higher voltage than
+40 V and the connected power may not exceed 1 W.

Output voltage: max. 250 V

Output energy in normal operation: max. 300 mJ (depending
on the ignition coils used)

Output energy in the start phase (boost): max. 500 mJ
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4 Product Description

Frequency of the pickups
i The frequency of the pickup is calculated as per the following formula.
LOverspeed(min] | Pikup Events per Revola
NOTICE Frequency-Tx lumber of PICkup Events per Revoiution

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface
— Compatible with USB 2.0

— The Connector B version is only suitable for temporary data exchange and not for a permanent
connection.

— Max. wire length 5 m (16.4")

CAN Bus Interface
— Classical Extended Frame Format (CAN 2.0B)

— As perISO 11898 standard, 50 kbit/s to 1 Mbit/s

— Transient-proof (automotive classification)

— Max. 110 participants

— Max. wire length 250 m (820') depending on the transfer rate

RS485 Interface
— According to TIA-485-A (03/2003)

— Max. 32 participants
— Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s
— Max. wire length 100 m (328') depending on the transfer rate

Pay attention to the wiring diagrams

) Depending on the device version, certain signals or interfaces described
1 in these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
NOTICE harnesses.

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC4.
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4 Product Description

4.1.8 Overview Drawings

Panel Mount Version
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4 Product Description

Light Duty Version
The connectors shown correspond to the standard version.
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4 Product Description

Heavy Duty Version
The connectors shown correspond to the standard version.
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4 Product Description

4.1.9 LED Functions

O Status

(O Firing
(O Pickup 1
(O Pickup 2
(O Pickup 3
O cpPoO
Labeling Function
Status Firmware version 1.11.00000 and higher:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
For details, refer to the following overview.
Older firmware versions:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
The LED flashes yellow if a warning has occurred.
The firmware version of your device can be found in the MICT in the window
Runtime Data — Information. Refer to the section Runtime Data — Information
on page 138.
Firing LED lights up when the ignition is active (exception: during the self test).
Pickup 1to 3 Flashing LEDs indicate activity of the pickups.
GPO LED is on when the GPO is activated.

Indication via the Status LED (from Firmware Version 1.11.00000 and Higher)

The flashing sequences shown below are repeated until the device has left the respective state
again. However, the flashing sequences are always executed to the end and are not interrupted
accordingly.

The status LED flashes green:

—  Waiting for sufficient supply voltage
Fast flashing green/off 100 ms

— Synchronization/firing active
Flashing one time green 250 ms on, 750 ms off

28 Rev. 01/2026



4 Product Description

Ready for operation
slow flashing green/off 500 ms

Bootloader — connection to computer started/update mode
Flashing one time green 2,000 ms on, 250 ms off

Firing locked
3 flashes green/off 250 ms, 750 ms off

Configuration/wait for 0 RPM
6 flashes green/off 250 ms, 750 ms off

The status LED flashes red:

Critical error/assertion
fast flashing red/off 100 ms

Operational error — general/system error
slow flashing red/off 500 ms

Bootloader - faulty firmware
Flashing one time red 2,000 ms on, 250 ms off

Operational error — pickup
2 flashes red/off 250 ms, 750 ms off

Operational error — overspeed
4 flashes red/off 250 ms, 750 ms off

Operational error - insufficient supply voltage
5 flashes red/off 250 ms, 750 ms off
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4 Product Description

The status LED flashes orange:

— Selftest

Flashing one time orange 250 ms on, 750 ms off

4.1.10 Connections and Functions under the Service Cover

4 ™
Power  USB Pickup
[FaWa| = pOB
B
— = 1A® T 234567801010
CAN B® Binary Output
734506780101

. v
Labeling Function

8 %" Q Power Connection for the supply voltage (see Input Wiring — Power Supply on

2483 page 37)

o=

g % §_ USB USB connection for connecting to the computer

(e}

oS % PB Button acknowledges errors, warnings and alarms or triggers a reset of

o ) the ignition controller. Please refer also to the notice below.

= e A/B Potentiometer for the manual adjustment of the ignition timing. The
® setting only has an effect if the potentiometer in the MICT is activated.
Pickup Connection for the pickups (see Input Wiring — Pickups on page 39)

CAN CAN interface for connecting external equipment (see Output Wiring —

Binary Output

RS485

Analog/Binary Input

30

CAN Bus Interface on page 48)

Connection for binary outputs (refer to Output Wiring — Binary Outputs
(Go/NoGo, GPO, ASO) on page 44)

RS485 interface for connecting external equipment (see Output Wiring —
RS485 Interface on page 50)

Connection for timing & safety devices (see Input Wiring — Timing and
Safety Devices on page 41)
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|

NOTICE

Rev. 01/2026

Behavior of the button PB
With the PB button on the device you can perform the following actions:

Press briefly (< 3 s):
Existing warnings are acknowledged.

Press longer than 3 s:

If no pickup signals are detected and an operational error exists, this
will be acknowledged together with all alarms. Warnings are
acknowledged in any case, even if no operational error exists.

Press longer than 15 s:
If no pickup signals are detected, the ignition controller restarts.
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5 Installation Instruction

5.1 Unpacking

Unpack the equipment, taking care not to damage it. Always place the device safely and protected
from falling over or falling down. Ensure that the operating manual is always stored with the
ignition controller and is easily accessible. Check the contents for completeness and verify that
the device type meets your application requirements.

Scope of Supply

The scope of supply of the MIC4 ignition controller consists of the following components:
— Ignition controller of the MIC4 series

— Installation set incl. four vibration dampers

— Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints

— Storage device with configuration software MICT and operating manual

— Safety instructions for the MIC4

— USB interface cable for connecting the ignition controller to a computer

5.2 Installation of the Ignition Controller

The installation of the MIC4 ignition controller is implemented on a fixed bracket, e. g. on a wall
near the engine, for the Light Duty or Heavy Duty Version. Install the Panel Mount Version in a
suitable control cabinet. Use the included rubber vibration dampers and the ground strap for all
three versions. The installation location of the controller must be selected so that the distance to
the pickups installed on the engine ensures a reliable signal transmission to the ignition controller,
and so that there is adequate space for maintenance and repair work. The mechanical
specifications must always be complied with (refer to Mechanical Data on page 17). The ground
strap serves to ground the ignition controller and must be used accordingly. Ensure a flawless
electrical connection for this purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the warranty being voided. The permissible temperature ranges are:

— Panel Mount Version: =20 °C (-4 °F) to +50 °C (+122 °F)
— Light Duty Version: —40 °C (-40 °F) to +60 °C (+140 °F)

— Heavy Duty Version: =40 °C (-40 °F) to +70 °C (+158 °F)
To ensure sufficient cooling through the cooling body, the Heavy Duty Version must be
mounted so that the vanes of the cooling body are vertical and the hot air can escape upwards
unimpeded.

Risk of destruction!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components. This also applies
if vibration dampers are used.
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5 Installation Instruction

5.2.1 Installation of the Vibration Dampers
There are two options for using the vibration dampers from the MIC4's scope of supply. The hole
patterns can be found in section Overview Drawings on page 25.

Option A

screws M8x16 , four rim lock washers
M8 Bl and four washers M8 E.

2. Fasten the MIC4 to the vibration dampers.
Use four washers M8 Bl and four lock nuts
msE.

» Fasten the ground strap to the ground
pin (see Installation of the Ground Strap
on page 34).

W 27 Nm /19 oot 1. Fasten thle four v!bratlon r.jampers H to the
selected installation location. Use four
T

L

an

A 27 Nm /19 Ib-ft

o H

Rev. 01/2026 33



5 Installation Instruction

Option B
1. Fasten the four vibration dampersnto the
8 27 Nm /19 Ib-ft MIC4. Use four screws M8x16 B, four rim
lock washers M8 Bl and four washers M8 .
2. Fasten the MIC4 to the selected installation
location using the vibration dampers. Use
four washers M8 E and four lock nuts M8

» Fasten the ground strap to the ground
pin (see Installation of the Ground Strap
on page 34).

i

—=

= [
@ 27 Nm /19 Ib-ft

5.2.2 Installation of the Ground Strap

1. Fasten the ground strap H to the MIC4
E ground pin. To do so, use one washer M6 H,
one tooth lock washer A6 Ell and one poly
- lock nut M6 .
2

/8 11Nm / 8 |b-

=4

o] o]

Connect the ground strap to one of the sides
suitable for grounding.

|

> You can wire the ignition controller as
described in section Wiring of the
Device on page 36.

(schematic representation)
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5 Installation Instruction

5.3 Determine the Installation Location of the Pickup

Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use only,
multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate the
calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 39).
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6 Wiring of the Device

6.1 Input and Output Wiring on the Controller

36

1

NOTICE

1

NOTICE

Operational safety!

All connector screws and screw joints must be adequately tightened.
Refer to the section Mechanical Data on page 17.

After the service cover on the device (Light Duty and Heavy Duty Version)
has been opened, e.g. to complete the wiring, it must be refitted so that it
is in the same alignment as it was prior to opening. The USB connection is
then again behind the service screw. If the mounting is rotated,
maintaining the indicated protection classes, as well as compliance with
CSA-Class I, Division 2 (Group C, D) is impaired.

Operational safety!

Improper wiring using the PG screw joints impairs the compliance with
the specified protection classes as well as with CSA Class I, Division 2
(Group C, D). Please adhere to the following points:

— Do not pass any cables without matching sealing inserts through the
PG screw joints.

— Asealinginsert must be used in every PG screw joint.

— Unused bore holes for the sealing inserts must be sealed using
sealing plugs.

— The PG screw joints must be adequately tightened.

For additional information on PG screw joints and sealing inserts please
refer to Mechanical Data on page 17.

Assignment of the wire colors

Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring diagram enclosed with the wiring
harness.

Pay attention to the wiring diagrams

Depending on the device version, certain signals or interfaces described
in these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
harnesses.
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6 Wiring of the Device

6.1.1 Input Wiring — Power Supply

|

NOTICE

Rev. 01/2026

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Design of power supply

For the power supply, an overcurrent protection mechanism must be set
up with a circuit breaker (16 A DC with tripping characteristic B), which
allows switching off. When selecting the circuit breaker, the conditions of
the installation site and the ambient temperature must be considered. The
circuit breaker must be easy for the user to access and marked as a
disconnecting device for the ignition controller.

If the power is supplied via a power supply unit, the following
specifications must be observed additionally:

— Voltage: 24 V DC; Current: at least 25 A
— Wiring: at least 1.5 mm?2 cross-section
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6 Wiring of the Device

L 224V DC (nominal voltage)

38

— |+

00

L- L+

Battery Generator Control unit
Power supply
+ —0
~
Battery Charger
= p—0
s
0
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6 Wiring of the Device

6.1.2 Input Wiring — Pickups

Example Configuration (one Active, two Passive Pickups)

Camshaft
>
Crankshaft
j |: O (Reset)
Crankshaft
g |

()
)

Power 6

s O = O
5 3 5 3 :
@ [

o

Power

Shield [(==).
(=)
Signal e
N0 |(2)
shieid | (&)

Shield
Power

Pickup 1 Pickup 2 Pickup 3

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the
different conditions of the engines.
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6 Wiring of the Device

One revolution of the pickup changes the distance as follows:

Thread Change in distance
M12x1 1revolution 2 1 mm (0.04")
5/8"-18 UNF 1revolution 2 1.41 mm (0.05")

3/4"-16 UNF

1revolution 2 1.59 mm (0.06")

Allocation of the Wire Colors (Example Configuration)

Camshaft
PIN Designation
1 Pickup 1 Power

2 Pickup 1 Signal
3 Pickup 1 GND
4 Pickup 1 Shield

Crankshaft (Reset)

PIN Designation

6 Pickup 2 Signal
7 Pickup 2 GND
8 Pickup 2 Shield
Crankshaft

PIN Designation

10 Pickup 3 Signal
1 Pickup 3 GND
12 Pickup 3 Shield

Wire color
Brown
black
Blue
Shield

Wire color
Flywheel with pin
White

Flywheel with pin
Brown

Shield

Wire color
White
Brown
Shield

Flywheel with hole
Brown

Flywheel with hole
White

For problems with the pickup signals, refer to the section Pickup Input Errors on page 159.

Adjusting the pickup sensitivity

necessary to increase the pickup sensitivity to ensure that the resultant

1 Depending on the type of impulse source (interference), it may be

signal strength is sufficient for reliable operation. You can make these

NOTICE adjustments in the MICT. Refer to the section Engine — Pickups on

page 96.

40
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6 Wiring of the Device

Auxiliary pickup supply voltage

) An auxiliary supply voltage for active pickups can be configured using the
1 MICT. The voltage can be set in the range from 5 V to 24 V and is supplied
at the connections Pickup 1 Power to Pickup 3 Power. Refer to the section

NOTICE Engine — Pickups on page 96.

6.1.3 Input Wiring — Timing and Safety Devices

The input wiring of the timing and safety equipment is dependent upon the hardware version of
the ignition controller. These are found in the MICT in the view Runtime Data — Information (refer
to section Runtime Data — Information on page 138).

Wiring Hardware Version 1.3.x/1.4.x (Example Configuration)

—i} * See subsequent drawings for details
x = bridge for permanent authorization
(must be removed for external ignition
+) authorization)
Switch Start/Stop
— open Ignition — OFF
-
closed Ignition — ON
—a/.—<
—{ 1 switchas
open Schedule A
q q
closed Schedule B

Timing U in + @
Analog GND @
Analog Power @
Timing Iin - @
Timing | in + @
Analog Shield @
Start/Stop + @
Schedule A8 + (=)
Binary Shield @
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6 Wiring of the Device

Wiring Hardware Version 1.2.x (Example Configuration)

* See subsequent drawings for details

x = bridge for permanent authorization
(must be removed for external ignition
+) authorization)
Switch Start/Stop
— open Ignition — OFF
-—y
closed Ignition — ON
—a/.—<
Switch A/B
open Schedule A
q g
ﬁ closed Schedule B
—]

DOEHOEOOOEE ]

+ % 5 1 + % + s+ % +

£ 2 £ £ 2 2 & m 8 =

S :c388S35 5k

2 2 » £ £ P B & 35 T

E £ s EE= S & 8 E

- =< =z Z g m

X ‘
X
Two-Wire Transmitter Four-Wire Transmitter

Analog Power

N\

Analog Power

‘ Timing lin +

Timing lin—

------ Analog GND

+V
+1 Timing | in +

Timing | in -
-V \VA Analog Shield

Analog Shield

42
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6 Wiring of the Device

1

NOTICE

EXAMPLE

Rev. 01/2026

Auxiliary supply voltage for the analog inputs

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog Power. Refer to the section Timing —
Analog Inputs on page 100.

Wiring MIC4 ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of an MIC4 ignition
controller with a DetCon detonation control system in cases where the
analog current signal (4-20 mA) at the output / out is to be used for the
ignition timing adjustment.

=
+ @ =) o
c 2 g L - - e 2
> &a EEn 8 2 85
2 2 2 2 2 28 3 *f = =
€ 8 8 §E E & 5 £ 5 &8 &
- S S B B c C
A e e S e Al A e MIC4-
( )(:)(:H:H:)(:)(:).(:).() ignition
| | e @ | controller
DetCon
IOOOCOO0OOOOOQQ) detonation
control system
r L&, E 58 PE £ | +
5 588358 §Fg238 § - -
= e = Eg 22
1 SR e

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to

24V in the MICT. Refer to the section Timing — Analog Inputs on page
100.

The timing is transmitted by MIC4 via the auxiliary synchronization output
(ASO) to the DetCon, and will need to be wired and configured
accordingly. Refer to the section Output Wiring — Binary Outputs
(Go/NoGo, GPO, ASO) on page 44.
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6 Wiring of the Device

General purpose input GPI

) The general purpose input GPI can be assigned various functions via the
1 configuration. Refer to the section Inputs/Outputs — Inputs on page 109.
NOTICE

6.1.4 Output Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

Example Configuration

oL+

*) DetCon or other external device (for wiring
of the DetCon, see following example)

K2 I'" K1=Go/NoGo relay

K2 = GPO relay
L27VDCto32VDC

o |-

Ay

ield

Go/NoGo + @
GoNaGo - [()
PO+ [(=)
6PO- |(=)
As0 + [(=)
As0- [(=)
Shie! @
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6 Wiring of the Device

L+ o| +

l Qut +

Al | Qut-

$ E _ﬁ Relay Al I
A2
# E 'ﬁ Relay
Out + A2
TOut -

o| - ol -

(L27VvVDCto32VDC)

DetCon connection

Connect the ASO output on the DetCon to the connections in A and in B
on connector Synchronization.

EXAMPLE DetCon

Synchronization

inA
inB

Y

Gomogo+ |0
GalNoGo - |(~)
epo+ |(=)
ero- |(=)
Aso+ [(=)
Aso- |(=)
shield (=)
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6 Wiring of the Device

6.1.5 Wiring — PowerView3, PowerView4
Connect a PowerView3 or PowerView4 HMI module to the MIC4 as follows.

CAN Connection between Ignition Controller and the PowerView

If the PowerView is to be connected exclusively to the MIC4 ignition controller via CAN, you can
connect it directly to the MIC4 using the CAN cable supplied with the PowerView, as shown in the
following illustration. To do so, you need to insert the connector in the CAN interface on the
PowerView. On the MIC4, connect the wires of the CAN cable to the corresponding CAN interface
connections. The assignment of the wires can be found in the wiring diagram enclosed with the
CAN cable or in the PowerView operating manual.

k]
£ .% o = % g Connector for CAN interface on the PowerView
w9 £ & O
L1 [
D
* "
— CAN cable
q .
|® @ @ @ @ @ ® | CAN interface on the ignition controller
523
3 S g g * To avoid ground loops, connect the shield on one
g g side.
Ll:l—l
1200

Power Supply of the PowerView via the Ignition Controller

If you use a MOTORTECH ignition controller with a service cover and connector strip and do not
supply any other devices with power via the PowerView, you have the option of supplying power
to the PowerView via the ignition controller using the power supply cable provided with the
PowerView. For this purpose, a special connector is included in the PowerView's scope of supply.
The connector for the voltage supply of the ignition controller must be replaced by this one.

Connector supplied with Connector supplied with
the ignition controller: PowerView:
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6 Wiring of the Device

Proceed as follows:
1. Disconnect the power supply to the ignition controller and, if necessary, to the PowerView.
2. Remove the connector for the power supply from the ignition controller.

Negative terminal: Disconnect the conductor from contact &l and insert it into contact lid of
the connector provided with the PowerView.

4. Positive terminal: Disconnect the conductor from contact E& and insert it into contact &8 of the
connector provided with the PowerView.

5. Plugthe wire L — (white) from the power supply cable provided with the PowerView into
contact . For plugging into the contact, use a wire end ferrule provided with the PowerView.

6. Plugthe wire L + (brown) from the power supply cable provided with the PowerView into
contact B4. For plugging into the contact, use a wire end ferrule provided with the PowerView.

7. Insert the connector provided with the PowerView into the power supply connection of the
ignition controller.

8. Insert the connector at the other end of the power supply cable from the PowerView's scope
of supply into the PowerView power supply connection.

9. Ensure that the power supply cables to the ignition controller and between the ignition
controller and the PowerView are correctly fused.

10. Connect the device's power supply.

» The power supply of the PowerView is now provided through the connector on the
ignition controller.
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6 Wiring of the Device

6.1.6 Output Wiring — CAN Bus Interface

48

1

NOTICE

CAN bus wiring
Note the following when connecting the CAN bus:

Each bus end must be fitted with a terminating resistor of 120 Q (see
drawing).

Only use cables that are specified by the manufacturer for use in the
CAN bus.

The shield must be connected across the entire bus cable.
The cable shielding must be connected to earth at a single point.

The reference potential (Com) of the CAN bus must be connected to
earth at precisely one point.

The maximum cable length depends on the bit rate:

Bit rate Maximum cable Maximum length Maximum length
length of a stub of all stubs

1 Mbit/s 25m (82") 1.5m (5") 7.5m (25"

800 kbit/s 50 m (164") 2.5m (8" 12.5 m (41)

500 kbit/s 100 m (328") 5.5m (18" 27.5m (90")

250 kbit/s 250 m (820") 11 m (36') 55 m (180")

125 kbit/s 500 m (1,640") 22 m (72" 110 m (360")

50 kbit/s 1,000 m (3,280') 55 m (180") 275 m (902"

Comply with the standards ISO 11898-1 and CiA® 303-1.
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6 Wiring of the Device

The product must be connected to a CAN bus as follows:

First device Second-to-last device
= E = 5 € =
£ 8 35 283
CAN Bus
& £ 3 [rma // R=120 0
T \\

[ole]elololelele]
5 = < 0
3° %
Q
Second device Last device

Notice: The CAN-Bus connectors 1-4 are currently unavailable.

CANopen® protocol
® If you require information on the CANopen® protocol of your MIC4,
1 contact your MOTORTECH contact person (see section Customer Service
Information on page 160).
NOTICE
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6 Wiring of the Device

6.1.7 Output Wiring — RS485 Interface
The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the

cable.

Two-Wire Wiring

First device

RX +
RX —

M=
TX +

Four-Wire Wiring

((

Second device

A\
))

Second-to-last device

First device
(Master)
RX + 4
i3 ( i3
RX -
TX - AN
. )) 2
TX+ 7 /
+ 1 1 - + 1 1 +
E EE F E EEE
Second device Second-to-last device
(Slave) (Slave)
50

Last device

RX+
RX -

Ti=
X+

Last device
(Slave)

TX+

TX-
RX -

RX +
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6 Wiring of the Device

Connection on the Ignition Controller

TX+

RS485

TX -
Com

RX +

A

RS485 TX + 6
Rs485 X - [(~2)
Rs485 Com |(e2)
Rs485 RX + |(=)

|

NOTICE

Rev. 01/2026

Rs485RX - [(&) RX -
Shield [(=>) J

Wiring of the RS485 interface

Follow these instructions for the RS485 interface wiring:

— Max. 32 devices can be connected to a bus.

—  The maximum wire length is 100 m (328') depending on the transfer
rate.

— Each bus end must be fitted with a terminating resistor with 120 Q in
each pair of leads (as indicated in the drawing).
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6 Wiring of the Device

6.2 Ignition Coil Wiring

52

1

NOTICE

|

NOTICE

1

NOTICE

Protection when using wiring rails

Every wiring rail on the engine block should be grounded to avoid
disruptions in the device caused by secondary current in the ignition
coils.

Ignition coil wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— Wired in straight order

— Wired in firing order

For information on straight order wiring refer to Straight Order Wiring of
the Ignition Outputs on page 55 and Engine — Parameters on page 88.

For wiring in firing order, the first cylinder in the firing order is connected
to the A1 output, the second to B1 (A2 for one output board), etc.

If a different wiring was implemented, the output configuration in the
MICT must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 88).

Conductor cross-section for primary wiring

If you do not use a harness manufactured by MOTORTECH, the primary
wiring must have a conductor cross-section of 1.5 mm2.
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6 Wiring of the Device

6.2.117-Pole Connector — Standard

The table contains the pole assignment for the Light Duty and Heavy Duty MIC4 for 8 and 16

cylinders.

(View: 17-pole connector from the outside)

)
o
o

16 outputs
Output A1
Output B1
Output A2
Output B2
Output A3
Output B3
Output A4
Output B4
Output A5
Output B5
Output A6
Output B6
Output A7
Output B7
Output A8
Output B8

Ground

= »w v vV Z M X« IO Mmoo o >

Rev. 01/2026

8 outputs
Output A1
Output A2
Output A3
Output A4
Output A5
Output A6
Output A7
Output A8
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned

Ground
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6 Wiring of the Device

6.2.2 10- and 9-Pole Connector (Panel Mount Version)
The tables show the pole assignments for the Panel Mount Version with a 10-pole and a 9-pole
connector:

Connector A Connector B

OOOOEEOOEO®| [(WOOOOEEOEE

Pin Assignment Connector A

Pole 16 Outputs / 8 Outputs
1 Output Al
2 Output A2
3 Output A3
4 Output A4
5 Output A5
6 Output A6
7 Output A7
8 Output A8
9 Ground

10 Ground

Pole Assignment Connector B (not Available for 8 Outputs)

Pole 16 outputs

1 Output B1

Output B2

Output B3

Output B4

Output B5

Output B6

Output B7

Output B8

Ol oo N o g MO DN

Ground
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6 Wiring of the Device

6.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use MOTORTECH wiring rails for straight order wiring, it is
absolutely necessary that they are correctly selected and installed for the
respective engine. Even a rotated installation can cause serious damage
to the engine, for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many engines
with predefined output configurations in the engine database. That means that if the wiring is
carried out accordingly and the option wired in straight order (user defined orientation) is selected
in the MICT, no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the wiring
rail are identified with Connector Pin 1to Connector Pin X.

— Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).
Execution of straight order wiring is dependent on the following factors:

— Output connector on the ignition controller (17-pole connector [Light Duty/Heavy Duty
Version], 10-pole/9-pole connector [Panel Mount Version])

— One or two output banks in the ignition controller (8 or 16 outputs)
— Type of engine (in-line or V-engine)
— Alignment of the wiring rail(s)
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6 Wiring of the Device

6.3.1 Straight Order Wiring for the Panel Mount Version

Panel Mount Version with 8 Outputs (One Output Bank)

Connector A

OOOOOOOOO

Wiring Connector A (Connector B not used with 8 outputs)

Pole

Ol N o g M O N

—
o

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail

56

8 outputs
(one output bank)

Output A1
Output A2
Output A3
Output A4
Output A5
Output A6
Output A7
Output A8
Ground

Ground

In-line engine

Connector*
1
1

Coil**

1

o N o a b~ WOWN

V-engine

Connector*
1
2

Coil**
1

—_

N ORI OREN \CRN V]
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6 Wiring of the Device

Panel Mount Version with 16 Outputs (Two Output Banks)
Connector A Connector B

OEOOOEROEOM| DEOOOEOEE)]

Wiring Connector A

Pole 16 outputs In-line engine V-engine
(two output banks)
Connector* Coil** Connector* Coil**

1 Output A1 1 1 1 1
2 Output A2 1 3 1 2
3 Output A3 1 5 1 3
4 Output A4 1 7 1 4
5 Output A5 1 9 1 5
6 Output A6 1 1 1 6
7 Output A7 1 13 1 7
8 Output A8 1 15 1 8
9 Ground

10 Ground

Wiring Connector B

Pole 16 outputs In-line engine V-engine
(two output banks)
Connector* Coil** Connector* Coil**

1 Output B1 1 2 2 1
2 Output B2 1 4 2 2
3 Output B3 1 6 2 3
4 Output B4 1 8 2 4
5 Output B5 1 10 2 5
6 Output B6 1 12 2 6
7 Output B7 1 14 2 7
8 Output B8 1 16 2 8
9 Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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6 Wiring of the Device

6.3.2 Straight Order Wiring for Light Duty and Heavy Duty Version

Light Duty and Heavy Duty Version with 8 Outputs (One Output Bank)

(View: 17-pole connector from the outside)

Pole 8 outputs In-line engine V-engine
(one output bank)
Connector* Coil** Connector* Coil**

Output A1 1 1 1 1
Output A2 1 2 2 1
Output A3 1 3 1 2
Output A4 1 4 2 2
Output A5 1 5 1 3
Output A6 1 6 2 3
Output A7 1 7 1 4
Output A8 1 8 2 4

=Sl »wl o0V Z I r X« T O Mmoo o >

Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail

58 Rev. 01/2026



6 Wiring of the Device

Light Duty and Heavy Duty Version with 16 Outputs (Two Output Banks)

-
)
@
(View: 17-pole connector from the outside)
Pole 16 outputs In-line engine V-engine
(two output banks)
Connector* Coil** Connector* Coil**

A Output A1l 1 1 1 1
B Output B1 1 2 2 1
(¢} Output A2 1 3 1 2
D Output B2 1 4 2 2
E Output A3 1 5 1 3
F Output B3 1 6 2 3
G Output A4 1 7 1 4
H Output B4 1 8 2 4
J Output A5 1 9 1 5
K Output B5 1 10 2 5
L Output A6 1 1 1 6
M Output B6 1 12 2 6
N Output A7 1 13 1 7
P Output B7 1 14 2 7
R Output A8 1 15 1 8
S Output B8 1 16 2 8
T Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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7 Functions

The ignition controllers of the MIC4 series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

-4 All angles in this operating manual are given in °crankshaft. Exceptions
1 are clearly identified.
NOTICE

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each input.
For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 96.

7.2 Monitoring of Pickup Signals

The MIC4 monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 159.

7.3 Go/NoGo

The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when
the ignition switches off. The max. switching current is 100 mA. The output can drive an external
relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
— Overspeed

— Pickup error

— Error HV power supply

— Failure of the output monitoring

— Overload/temperature shut-down

- Alarms

— Insufficient supply voltage (Low Power)
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7 Functions

Use master control
. The outputs of the MIC4 are not SIL compliant. Therefore, always use an
1 additional master control for safety-critical applications.
NOTICE

7.4 Ignition Timing Adjustment

The ignition controller has several functions for the timing correction.

Influences on ignition timing

e Be aware that the actual timing of the engine can also be influenced by

1 external signals (e.g., analog current or voltage input).

NOTICE

Operational safety!

The MIC4 ignition controller must first be correctly configured for the
engine being used before you can start the engine.

An incorrect configuration can result in damage to the engine.

Rev. 01/2026
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7 Functions

The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol. Depending on the device version,
some functions might not be available.

62

Per schedule:

| Base Timing

| Speed Curve

| Analog Voltage Input

| Analog Current Input

[ Potentiometer

Global:

| Ignition Timing Correction

Per cylinder:

Cylinder Individual
Offset

Limited by the
min./max. cylinder
individual offset

Limited by the
min./max. Timing
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7 Functions

7.4.1 Manual Timing Correction

The ignition controllers of the MIC4 series include two permanently installed overwind-protected
potentiometers for manually correcting the ignition timing. The max. range is defined with the
corresponding limits that are set by the user. Potentiometer A adjusts the ignition timing of
schedule A and potentiometer B adjusts the igniting timing of schedule B.

7.4.2 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be supplied,
for example, by a potentiometer, a pressure sensor for charging pressure, or a detonation
controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.

The levels of the analog inputs can be set in the range from 0 mA to20 mAand 0 Vto10 V. You
can make this configuration with the MICT. Refer to the section Timing — Analog Inputs on
page 100.

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be used
for supplying power to external sensors.

Rev. 01/2026 63



7 Functions

Configuration examples

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

Input current: 4 mA to 20 mA

EXAMPLE

— Input voltage: 0 Vto5V

Characteristic 4 mA to 20 mA /0 V to 5 V - Ignition timing adjustment

towa

rd retarded.

BTDC

4

40°

30°

20°1

10°+

4mA oV -
B Base Timing 30° BTDC

15° retarded ignition
20mA 5V

0°

>t

Characteristic 4 mA to 20 mA /0 V to 5 V - Ignition timing adjustment

towa

rd advanced.

BTDC

4

40°

30°+

20°1

10°+

3

20mA 5V L
15° advanced ignition

Base Timing 15° BTDC
4mA oV

o°
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7 Functions

7.4.3 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 146.

Use of measuring unit

. Use this setup option only if a suitable measuring unit is available for

1 determining the optimum timing point, so that the result of a change can
be assessed immediately.
NOTICE

7.4.4 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC4 ignition controllers. To create this curve, up to eight adjustable speed points
are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B —
General on page 101.

7.4.5 Ignition Timing Correction

Via the ignition timing correction, the global ignition timing, limited by the timing limits of the
current schedule, can be adjusted. Refer to the section Runtime Adjustments — Timing on page
142.

7.5 Firing Angle
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

Overspeed [min'll

Ignition Angle = ————  x 360°x1.7ms
60

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.
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7 Functions

7.7 Output Monitoring

Electronic switches are used for the ignition outputs of the MIC4 ignition controller If one of these
switches is defective, this would lead to a primary short or a primary open output. This can cause
problems when operating the engine or can damage the engine. The function of the outputs is
therefore monitored and errors that occur are displayed in the runtime data in the MICT or can be
transmitted via fieldbuses. Different alarms are available for monitoring the misfire rate. It can also
be defined that the ignition is switched off in the event of output errors. Refer to the section
Inputs/Outputs — Alarms on page 105.

7.8 Schedules A/B
The MIC4 ignition controllers offer two separate schedules for the parameterization of the ignition
timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Refer to Timing — Schedule A/B — General on
page 101 and Timing — Schedule A/B — Energy on page 103.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked
to schedule B (switch closure). If a wire ruptures, schedule A is
automatically selected with the retarded (and thus safer) timing point.

7.9 Alarms

The MIC4 ignition controllers include 16 freely configurable alarms in total.
— Limit for speed exceeded/not reached

— Limit for engine operating hours exceeded/not reached

— Limit for spark plug operating hours exceeded/not reached
— Warning active

— Erroractive

— Limit for temperature exceeded/not reached

— Limit for supply voltage exceeded/not reached

— Limit for global ignition timing exceeded/not reached

— Limit on the analog voltage input exceeded/not reached

— Limit on the analog current input exceeded/not reached

—  Limit of the minimum spark duration exceeded/not reached
— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) above threshold
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— Consecutive misfires (primary, single output) above threshold

— Misfire rate (secondary, individual output) above threshold

— Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold

— Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 105.

7.10 GPO: General Purpose Output

The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 105.

7.1 ASO: Auxiliary Synchronization Output

The ASO is an output of the MIC4 for synchronizing the MIC4 ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel injection
control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = traising — traing). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to the
engine rotation angle.A maximum of 16 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal precedes
the raising edge by the value of the pulse width. The controller calculates the duration of the
falling edge from high-level to low-level and then back to the starting value of the high-level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (Auxiliary Synchronization Output) on page 107.
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EXAMPLE

68

Application of the ASO signal

The following example will illustrate the application of the ASO signal:
— Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC4 and Valve Controller

cyl. Lgnition angle in ASO signal in Pulse duration in
crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

Schematic Representation (Standard Settings)

Level
160 s 80 ps 80 us 80 us 80 us 80 us

Hgh b P e __ 4> __ > __ > __ > ___

I 1 I 1 1 ] ) 1 1 1 I I 1

1 1 1 1 1 1 1

I 1 1 1 (] 1

i *)* i At I f ] f i f i f i
1 1 ] 1 1 1 ! 1 1 1 ] 1 1 ~
R, o0 Tieo 1240 360 1480 Teoo . Y
718 118 238 -358 478 508 crankshaft

* active edge

The valve controller should receive the active edge of the ASO signal
before the top dead center of a cylinder. The first pulse duration should
be twice as long and thus mark the beginning of a cycle. The ASO signal
generated by the MIC4 increases by 2° each time before the ignition
signal from Low to High, as can be seen in the schematic drawing. This
edge is analyzed by the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ys versus 80 us for other
cylinders. If the valve controller measures a pulse width of 160 us, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition
sequence, etc.

Rev. 01/2026
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7.12 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here different
settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B — Energy on page 103.

7.13 Access Control

The MIC4 has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MIC4 is activated,
it is independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC4

A user is logged in to the Advanced Service access level on the MICT. He

changes a configuration and would like to download the change to the

MICA4. Although he has the full authorization set in the MICT, he is
EXAMPLE prompted to log in with the PIN for the Level 3 (Master) on the MIC4.

A variety of functions are at your disposal in the four operating levels of the MIC4. The figure
below illustrates this:

Level 2: Service

LevelO:ReadOnly | Levell: Operator

Runtime Data Runtime Adjustment Runtime Adjustment
All Timing Reset Position
Energy

Secondary Voltage
Calibration

Commands Commands Configuration

Alarm Commands Set Engine Hours Download to Device
Error Commands Set Spark Plug Hours

Misfire Counter
Timing
Cylinder Individual Offsets

Access Control Access Control

Login Sell Test Reset All Pins
All Enable Access Control
Disable Access Control

Rev. 01/2026 69



7 Functions

The following functions are available on the different levels:

Level O (Read Only)
Enables read-only access for all users.

Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on this
level.

Level 2 (Service)

Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

Level 3 (Master)

On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT
on page 72.
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8 Settings via the MICT

MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your engine.
When working with the MICT, you can press the F1key at any time to access context-sensitive
help.

If you are using a different version of the MICT than shown in the following sections, the scope of
functions may differ.

8.1 MICT System Requirements

For the installation of the MICT, the following minimum requirements must be fulfilled:
— x86-compatible computer

— Display with a resolution of at least 1440 x 900 pixels (WXGA+)

— USBinterface 1.1 or higher

—  Microsoft® Windows 10, Windows 11

8.2 MICT Installation

Observe compatibility of MICT versions

& Older firmware versions of certain MOTORTECH devices are not

1 supported by the MICT version provided on the storage device, or are
only supported with restrictions.

NOTICE

When selecting the MICT version to be installed, refer to the compatibility
overview on the storage device supplied with the product.

The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.
To install the MICT, proceed as follows:
1. Start the installation:
— Viathe menu:

Start the file Start.exe on the storage device. Start the installation routine of the MICT via
Software -> Install MICT.

— Directly from the storage device:
Start the installation routine of the MICT directly. It is on the storage device in the
subdirectory Installation and for example named as follows: MICT-2.48.0-setup.exe.

2. Run the installation.
Follow the instructions of the installation routine. Note that the license agreement terms must
be accepted before using the MICT.
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3. Install the USB driver via the menu as well or directly from the storage device.

— Viathe menu:
Software -> USB Drivers -> Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers (e.g. CDM21226_Setup.exe).

> The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.

8.3 Access Levels in the MICT
Start the MICT on your computer.

In the window Change Access Level, select the access level for which you have clearance. The
access level controls the options you have at your disposal in the MICT. The password required
for access can be obtained from your MOTORTECH contact person (refer to Customer Service
Information on page 160). You can save the password for your access level using the button Save.
It then does not have to be entered again the next time the MICT is started.

B! Change Access Level x

Access Lavel
Read Only
O Customer
O service
(O Advanced Service

Password:

oK Save Cancel

The following access levels are available:

— Read Only
On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

—  Customer
This level enables the configuration of the basic functions required for operation in addition to
the read-only function.

- Service
This level contains all functions for a standard installation.

— Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you are logged in to a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

B unnamedimicd (MIC4 4x2.16) - MICT - o x

n“-g.\g Device  Settings Document Tools Help
B+ a&-9%#2 19 Q07 @

Configuration Page Perameters
~ Engine Engine Selaction ——
|2 Parameters| Engine Manufocturer Series Type: INew Engine Confiuration) | | Selected Fngine Sussrasey

Cylinder Names Engine Type: 4 atroke sgne

Ignition Qutputs

E__ Ignition Coils
Pickups

~ Timing

Bessemer
Analog Inputs
v Schedule A
General
Energy
v Schedule B
General
Energy
Miscellaneous
v Inputs/Outputs
Alarms
ASO1
Inputs
v Miscellaneous

Communication
Information y

(—d
MOTORTECH does not assume liabiity for the information in the engine database. Please contact MOTORTECH if dscrepandes

O

1f your engine is not avalable in the kst contact MOTORTECH service please.

@ COMS IDMICA 4x2.16 (1.5.1 [0000cBO1]) ADV.SERVICE Full Access Version: 2.48.0 -—E

Pos. Area

[ 1] Menu bar

Toolbar

Navigation bar
Configuration section
Status bar

The functions in the menu bar, navigation bar and toolbar as well as the configuration section will
be described in the following.
The status bar provides you with the following information (from left to right):

— Status display
Indicates whether a connection is established with the device:

— Green: Connection established
— Red: The connection was interrupted and is being restored
— Gray: The connection is not established and is not being restored
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— Indication of the interface being used for the connection to the device

— Indication of the device ID

— Indication of the access level of the user in the MICT

— Indication of the operating level for the MIC4 if access control has been activated and the user
has logged on with a PIN.

— Indication of the MICT program version

8.5 Menu Bar and Toolbar

The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:

Symbol

74

Menu

File -> New

File -> Open

File -> Save /
File -> Save As

File -> Recent Documents

File -> Close

File -> Open trace

File -> Open pickup trace

File -> Change Access Level

File -> Print

File -> Print to PDF File

File -> Print Preview
File -> Quit

Device -> Connect

Function

Creates a new configuration.

Opens an existing configuration.

Saves the current configuration.

The last five configuration files used are offered
for selection.

Closes the current configuration.

Opens a runtime data recording (trace file).
Refer to the section Runtime Data on page 113.

Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup Trace
on page 79.

Changes the MICT access level for accessing
the configuration data and functions.

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.
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Symbol Menu

E Device -> Disconnect

Device -> Download to device

N

=

Device-> Upload from device

Device -> Runtime data

Device -> Log

= Device -> Runtime adjustments

Device -> Cylinder individual
offsets

Device -> Self test

Device -> Pickup trace

Device-> Set spark plug
operating hours

Device -> Set engine operating
hours

Device -> Set Date and Time

Device -> Send command ->
Reset misfire counters

Device -> Send command ->
Acknowledge operational error

(Keyboard shortcut: Strg+R)

Rev. 01/2026

Function

Cuts the connection to the device.

Downloads configuration data from the
computer to the device. Refer to Working with
Configurations on page 83.

Uploads configuration data from the device to
the computer. Refer to Working with
Configurations on page 83.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 113.

Opens the window Log (Advanced Service
only). Refer to the section Log on page 139.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime adjustments on
page 140.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on page 146.

Opens the window Self Test (Service and
Advanced Service only). For this refer to
section Self Test on page 77.

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup Trace on page 79.

Opens the window Set spark plug operating
hours.

Opens the window Set Engine Operating Hours.

Opens the window Set Date and Time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operational errors are acknowledged. This
can only be implemented while the engine is not
running.
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Symbol Menu

Device -> Access Control

Device -> Temperature
Extremes

Settings -> Language
Settings -> Online update
settings

Settings-> Database settings

Settings -> Temperature scale

Settings -> Display by cylinders

Document -> Schedule Curve

Tools -> Coils
Help -> Help

Help -> About MICT

8.6 Online Update Settings

Function

The setup for the access control to the MIC4 is
described in a separate section. Please read the
section Access Control for MIC4 on page 81.

Opens the window Temperature Extremes in
which the minimum and maximum temperatures
of the controller and output boards are
displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Refer to the section Online Update Settings on
page 76.

Opens the window Database Settings in which
various databases can be assigned as source
for the MICT.

Opens the window Select Temperature Scale, in
which you can change the unit for the
temperatures shown in the MICT.

Not currently used.

Opens the window Schedule. Please refer to
the chapter Schedule Curve on page 147.

Opens a database with information on
MOTORTECH ignition coils.

Opens the online help.

Opens detailed information on the MICT.

Perform regular online updates
MOTORTECH is constantly expanding its databases. Perform regular

1 online updates to make optimal use of the opportunities that the MIC4

provides.

NOTICE
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The MICT uses data from an engine database and a coil database for the configuration. Such data
can be updated with automatic online updates. The settings for the update can be made using the
following entry in the menu bar:

Settings -> Online update settings

! Online Update Settings X

Enable automatic database updates
[[) Use a proxy to access the web
http-Proxy:

Port: 80 =

Show Log Update Now [Il Cancel

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is enabled and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Use aproxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.

- Show Log
With this button, you can open a window in which the online updates performed are logged.

— Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection between
the ignition controller outputs and the spark plugs. From firmware version 1.11.00000, the running
self-test is signaled on the device by the status LED flashing once (1 time orange 250 ms on,

750 ms off). Refer to the section LED Functions on page 28.
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Proceed in the MICT as follows:
Device -> Self test
M Self Test - (] X
WARNING

Inusing the self test feature it is critical that the fuel to the engine has
! been shut off and the engine purged of any fuel gas. Faiure to do this
could result in d |

n ge to and nearby
Status Cydes Cydle Time - All Configured Outputs
© Uninited O period so0000 (5] BS
P Lo O Lz O Fraquency 2,000 [2] Hz
Active Outputs Contrel
- Oa
D Ready

<60 Fsm PRses
QD COMS ID MIC4 4x2.16 (1.5.1 [0000c8O1))

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

- Locked
The ignition controller is in a state in which no self test can be done. For example, there is an
error or a configuration is currently being downloaded into the device.

- Active
The self test is running.

- Ready
The ignition controller is ready and the self test can be started.

You have the following options:

— Cycles
Determine whether the self test should run unlimited or be terminated after a defined number
of cycles.

— Outputs
Define whether all outputs or only a defined output should be fired during the self test.

— Cycle Time - All Configured Outputs
Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If you
only set one output for the self test, this would still only fire once per cycle.

— Control
Start or stop a self test using the corresponding buttons.
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8.8 Pickup Trace
The traces of the pickup signals support you in checking the behavior of the used pickup and thus,
for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just before
the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -> Pickup trace

Pickup trace
Example of a pickup trace for a configuration with three pickups:

—  Pickup input 1 (cam):
Single event from the camshaft

EXAMPLE

—  Pickup input 2 (reset):
Single event from the crankshaft
—  Pickup input 3 (trigger):
Trigger disc of type N with 160 events from the crankshaft

8 MICT - Pickup Trace - (=] X
File
Pickup Trace
43 == === e ———————
£
g B TR TR RO A |
3
>
'&1 I I T T T ] Y Y 0 | O 1

S T S —
2.000 4.000 6.000 8.000
Time [ms]

[
0

Operation
The following options are available via the menu in the window:

- Open
Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

- Close
Closes the pickup trace.
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There are the following options for the display of the pickup signals:

— Zoom In/Out
Using the mouse scroll wheel you can zoom in and out of the displayed record range.
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom
function, you can e.g. analyze the trigger signal more precisely (pickup input 3 in the drawing).

ML MICT - Pickup Trace - a x
Eile
Pickup Trace

3 |IIIIIIH\lIIIII]J\IIIIIII]JIIHIIIIIJIIHIIIIIJIIHIIIIIIHUIIIIIIH\IIIIIIIH\IIIIIIIH\[IIIII]H{lIIIIIIH\[IIIIIIH\IIIIIIIIIHIIIIIJIIHIIIII]\II[IIIIIHIIEIIIIIH\IIIIIIIIIHIIIII]

| |

Pickup Input
N

,,

U e e ] e e T e [ e P
4.620 4.640 4.660 4.680 4.700 4.720 4.740
Time [ms]
— Move displayed range
With the right mouse button pressed you can move the displayed range along the time axis.

— Measuring
You can measure distances and the number of events in the displayed range by holding down
the left mouse button to highlight a section. You can find the following information in the
window:
— Position on the time axis
— Time difference (A) between the two selected points

— Number of events counted in the selected period
M MICT - Pickup Trace - a x

Eile
Pickup Trace

—————————————————————

3
g_ 5792391!\‘5
= I1I\lIIIHIIHIIIIHIIIHIIH[IHIHIJI IIHIIHIHII I i ]
5 entd, min, period: 159,276 ms, max, period: 213,162 ms
_6 t!(pﬂﬂh\r!) 22€|l2n|!,n'l1-'|7¢ﬂﬂd_: 79.637 ms, max. p!fb_d. 114.677 ms
e [ R | T i e b i i e e b

2.000 3.000 4.000 5.000 6.000 7.000 8.000
Time [ms]

Error Analysis
The pickup traces support you, for example, in analyzing the following errors:

— Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the values
configured with the signals recorded (see Engine — Pickups on page 96).

— One or more pickups have failed.
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Pickup trace
. The pickup signals are only recorded on the inputs that are configured in
1 the MICT. If the configuration of the pickup inputs is not valid (e.g. three
signals from the same shaft), no signals are recorded.
NOTICE

8.9 Access Control for MIC4
If the access control to the MIC4 is activated, access to the following areas is possible with a PIN
only:

— Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

— Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).
— Configuration (Transferring a configuration to the MIC4)
The access control regulates the accesses to the device via the MICT. For explanations

concerning access control of the MIC4 and the delimitation of the access levels in the MICT, refer
to section Access control on page 69.

The access control functions can be accessed in the menu bar via:

Device -> Access Control

8.9.1 Enabling/Disabling Access Control

Enabling and disabling access control

. As a default setting, the access control is not enabled, and all PINs are set
1 to 0000. Once the access control has been enabled and the PINs have
been changed, these PINs will continue to be used. To re-enable the
NOTICE access control, you will need the PIN for level 3 (Master). It is therefore

recommended to reset all PINs before disabling.

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Reset All PINs
on page 82.

To enable or disable the access control, proceed as follows:

1. Open the input dialog via Device -> Access Control -> Enable or Disable Access Control.
2. Enter the PIN for the level Master (level 3).

3. Confirm the input with OK.
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8.9.2 Login/Logout

If the access control is enabled, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:

1. Open the input dialog via Device-> Access Control -> Login.
First select the level you wish to log on to.

Enter the PIN for the desired level.

Confirm the input with OK.

> Youare now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.

> oD

After completing the log-in, you can log out again as follows:

Device -> Access Control -> Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:

1. Open the input dialog via Device -> Access Control -> Change PIN.
First select the level for which you wish to change the PIN.

Enter the current PIN for the desired level.

Enter the new PIN in the two subsequent fields.

Confirm the input with OK.

> The PIN for this operating level has now been changed.

a kw0

8.9.4 Reset All PINs

To reset all PINs, proceed as follows:
1. Open the input dialog via Device -> Access Control -> Reset All PINs.

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with the
relevant PIN.

3. Confirm the input with OK.
To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
Confirm the input with OK.
> Al PINs are now reset to the value 0000.
To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1. Inthe menu bar, select the entry Device -> Access Control -> Get reset all PINs request key
to open a window with the same name.
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2. Send the request key with the serial number to your service contact person at MOTORTECH
(refer to Customer Service Information on page 160). This key is valid only for the respective
controller and only for a certain amount of time.

»  Your information will be verified, and you will receive an authorization key from your
contact person.

3. From the menu bar, select the entry Device -> Access Control -> Set reset all PINs
authorization key to open a window with this name.

Enter the authorization key received in the input field.
Confirm the input with OK.
> If the input was correct, all PINs are reset to the default value 0000.

8.10 Working with Configurations

To ensure that the MIC4 correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC4 as configuration data.

You can use the MICT to perform the following for these configurations:
— Create

- Open

- Edit

— Saveasafile

— Download to the MIC4

— Upload from the MIC4
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8.10.1 Cre

=

@

ate, Open, Save

Click on the symbol to create a new configuration and select the corresponding
device type. The device type corresponds to the first five digits of the
arrangement number, which you can find on a label on your device.

Click on the symbol to open a saved configuration.

ool Open Configuration File

x
& > v A « 08 (.. > MICT.. v G Search MICT Configuration @
Organize * New folder =~ 0O @
Narvie - Date modified Type Sixe
4 Enginel.micd 6/10/2021 8:26 AM MIC4 Config File 13KB
M Engine2.micd 6/10/2021 8:26 AM MIC4 Config File 13K
E"-} Engine3.micd

6/10/2021 8:26 AM MIC4 Config File

File game: | Enginel.micd v‘ IMIC4 Configuration Files (*.mic VI

Click on the symbol to save the configuration currently displayed in the MICT to a
storage device.
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Compatibility of the configuration files

. Configuration files are only compatible for the respective device type,

1 even if the file extension is identical. For example, files created for an
MIC3 cannot be downloaded to an MIC3+ and vice versa.

NONIEE To use a configuration for another device, the series and the first four

digits of the arrangement number must match. This information can be
found in the title bar of the configuration and on the respective device:

MIC3 MIC3+
W urmam:d.mi MIcT w unnamed.mi MicT
Fle Device Setings Document Tools Help Fle Device Setlings Document Tooks Help
A, 48" AERSRS 44"
Parameters | Parameters

Canfiguration Page
Engne Selector | |, g Engne Selector

OTORTECH'
| |

KNN 3)(1.12)(XXX‘XXXXAXX~X ‘ N 3;.-1‘_2)xxx—xxxx~xwx [

If, for example, a system is to be changed from an MIC3 to an MIC3+, the
configuration of the MIC3 can be saved as a PDF file. Then a new
configuration file must be created for the MIC3+ and the values from the
PDF file must be entered. Alternatively, the MICT can be opened twice
and the values transferred to a newly created configuration file.

| Cenfiguration Page
|~ [Engine

OTORTECH" WM

www.matortech.de
www.malortech.de

8.10.2 Upload, Download
= Click the symbol to upload the current configuration from the MIC4 to the MICT. If

S @ applicable, the MICT first establishes a connection to the MIC4 connected.

gw Click on the symbol to download the configuration set in the MICT to the MIC4.
» l\@ This function can only be executed while the ignition is not active. This action
i overwrites the existing configuration on the device. If applicable, the MICT first
establishes a connection to the MIC4 connected.
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Existing configuration is cleared!
°

|

NOTICE

If you download a configuration to an MIC4, the previous configuration is
deleted and the new settings are immediately implemented.

Runtime adjustments

-4 If you change a configuration stored in the MIC4 via runtime adjustments,

1 the configuration must be re-uploaded from the device so that the
changes are displayed in the MICT's configuration views.

NOTICE

8.10.3 Compatibility Information

M Information X

Some configuration values could not be loaded from the file. Assuming default values. You should recheck the i
Ioaded configuration. =

oK Show Detais...

If you upload a configuration from the MIC4 to the MICT that does not correspond to the version of
your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

— No values are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

— The configuration contains values for functions that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to an MIC4
whose firmware does not correspond to the version of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

— The configuration contains function values that are not support by the firmware.
If you download a configuration into the MIC4 and are notified of functions that are not supported

by the MICT, you should check the MIC4 settings. Re-upload the configuration from the MIC4 to
the MICT. You can then see in the MICT which settings were not applied.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC4 functions without restriction.
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8.11 Configuration

The window opens after you have selected the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration data
are then displayed in the configuration section and can be edited by you. The following sections
describe the settings you can implement in the different areas.

Indication of invalid entries

An invalid selection or invalid input values are highlighted by pulsating
1 warning signs in the configuration pages of the MICT. Additional
information is provided in the status bar.

NOTICE
Example:
Configuration Page | tgriton Outputs
~ Engine ‘ Output Bank A
Parameters.
Number of Outputs: & -

Cylinder Names
7 Ignition Outputs
Igniticn Cails

Pickups
> Timing ‘
~ Inputs/Outputs

Alarms.

ASD1

Inputs
v Miscellaneous

Communication

Information

1
2
k]
4
v (5 -
L]
7
&

ing Angle: 0.0 - 720.0, Default = 0.0, min. distance imited by overspeed (invalid due COMn/a IDn/a ADV.SERVICE n/a Version: 2480
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8.11.1 Engine — Parameters

M unnamed.micd® (MIC4 4x2.16) - MICT

Eile Device 3Settings Document

DAETHS Il W EB0EE

Configuration Page

v |E

Cylinder Names
Ignition Qutputs
Ignition Coils

Pickups

Analog Inputs
chedule A

General

" Energy
Schedule B
7 General

|| Energy
i Miscellaneous
~ Inputs/OQutputs
™
L Alarms
ASO1
Inputs
~ Miscellaneous
™ -
Communication
| Information

Engine Selection

- o x
Help

Engine Manufacturer Series Type New Engine Configuration Selected Engine Summary

RIAX E 08 Series E 2842 E 302 MAN - E 2842 LE 322

Bergen Diesel E 26 Series E 2842 E 312 -

Caterpillar £ 28 Series E 2242 LE 202 f;‘gk"e"v“'"“‘z"““ *

Clark E 32 Series E 2242 LE 302

Cooper Bessemsr E 2842 LE 312 Firing Angles

™ E 2842 LE 322 gboo

Guascor E 2842 LE 332 120.0

Ingersoll Rand E 2848 LE 322 210.0

Jenbacher E 2876 E 302 ol

Liebhers E 2876 E 312 2500

MAN E 287¢ LE 202 450.0

Nordberg £ 2876 LE 212 ﬁ‘g

Ruston E 2876 LE 302 §00.0

Sequence E 287¢ TE 302 690.0

Superior 0.0

Waukesha

MOTORTECH does not assume liabiity for the information in the engine database. Please contact MOTORTECH if
fi‘\ discrepancies are found.

If your engine is not available in the list contact MOTORTECH service please.

) COMS 1D MIC4 4x2.16 (1.5.1 [0000c801]) ADV. SERVICE Full Access Version: 2.48.0

The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the selected

engine, the Wiring dialog opens and you have the opportunity to adapt the output configuration.

! Wiring ? x
Pleasa select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the
output configuration afterwards.

O wired n firing order
© wired in straight order (user defined orientation)

Coil 1 7|0 o 1
s| o] [o] |2
sl [o |o||s
w|lo]| |of|+
1] |0 o 5
12| |0 o & Coil 1
Or:58 [FIFTFIED O£
o 7-12 m o 14

change orientation of rall | change harness  change orientation of rail

[ ]

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing

order needs to be configured directly in the ignition controller. The ignition coils on the wiring
rail are marked with Connector Pin 1to Connector Pin X. The position of coill on the wiring rail

is marked in the view Wiring.

— Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 55 (for example with an open wiring harness or

via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your selection.

If you want to use a different wiring, these settings must be adapted appropriately.

If the relevant engine is not available in the database, settings can also be made by selecting the
corresponding sequence. For this purpose, click on the entry Sequence in the column Engine

Manufacturer and select the firing stroke as well as the number of cylinders in the column Series

and the required ignition offset of the engine. After making your selections, a summary of the
selected parameters will be displayed in the section Engine Information on the right.

The summarized data are transferred to the subsequent configuration page Ignition Outputs. The

values displayed there can only be changed by users with authorization to access the Advanced

Service level.
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Engine database

. MOTORTECH does not assume liability for the information in the engine
1 database. Please contact MOTORTECH if discrepancies are found.
NOTICE

New Engine Configuration

Personnel with authorization for the Advanced Service level additionally has the option of setting
the engine data manually, i.e., without selecting from the engine database. For this purpose, click
on the New Engine Configuration button and select the engine type, the number of strokes, and
number of cylinders in the dialog box that subsequently opens. Additional information can be
entered on the configuration page Ignition Outputs.

! New Engine Configuration x
Engine Type: V engine !
Strokes: 4stroke &
MNumber of Cylinders: 12 -

Note: Spedify Firing Order and Firing Angles on the Ignition Outputs Page!

(o ) camce
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8.11.2 Engine — Cylinder Names

M unnamed.micd® (MIC4 4x2.16) - MICT - ] b4

Eile Device 3ettings Document Tools Help

QA EHYHS RS EBO0EE @

Cylinder Names

Configuration Page

~ Eogins @ Enzbie Cyinder Names
| Parameters

| Ignition Qutputs
Ignition Coils O
] Pickups ol
~ Timing 8
| Analog Inputs

~ 7] Schedule A 3

Bank Name: B Bank Name: A

ol

" General
=
" Energy
~ [ Schedule B 11
N
General

(OO0 0 O O 0
(O O 0 O O ©
-

] Energy

H‘

" Miscellaneous
~ Inputs/Qutputs

=Y

L Alarms

i1 ason

S

i Inputs
~ Miscellanecus

™ -

Communication

]
z
&

I Information

[ Show banks in reverse order

& COMS IDMIC4 4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2480

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you can
individually name each cylinder. The schematic representation of the plan view of the selected
engine supports you in this. Make the following settings:

— Enable Cylinder Names
Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. On this, refer to the section Engine — Parameters on page 88. If you
have activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs on page 92.

— Bank Name
Enter a name for the respective cylinder bank.

— Cylinder Names
Enter a name for the respective cylinder.
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[oR
- o3
currently not used

— Show banks in reverse order

currently not used

8.11.3 Engine — Ignition Outputs

M unnamed.micd” (MIC4 4x2.16) - MICT
Settings

Eile Device Document  Jools

uHFSRS N BOEE ©

Configuration Page

~ [Engine

| Parameters
Cylinder Names
Ignition Qutputs
Ignition Coils
I Pickups
~ Timing
7 Analog Inputs
~ 7] Schedule A
| General
 Energy
~ [ Schedule B
7 General
j Energy
{7 Miscellaneous
~ Inputs/Outputs
) Alarms
i1 aso1
7 Inputs
v Miscellanecus

" Communication
7 Information

o X
Help
Ignition Outputs
Output Bank A Output Bank B
Number of Qutputs: | & Number of Outputs: &
Cylinder Qutput Angle (7] Angle [ Output Cylinder
1 *|l1 0.0 450.0 4 7 .
2 b £ L 480.0 210.0 2 8 w”
3 hd ) 240.0 650.0 (3 9 =
4 v 6 600.0 330.0 3 10 >,
5 r||2 120.0 570.0 5 11 i
L] b ) 380.0 $0.0 1 12 b
notassigned ¥ 7 0.0 0.0 7 not assigned
notassigned v 8 0.0 0.0 3 not assigned ~

D COMS 1D MIC4 4x2.16 (1.5.1 [0000c801]) ADV. SERVICE Full Access Version: 2.48.0

Make adjustments to the following settings as needed:

— Number of Outputs

Select the number of outputs for the respective output board.

—  Column: Cylinder

Select a cylinder. The displayed names are specified on the configuration page Engine —

Cylinder Names.
—  Column: Output

Select the number of the respective output.

— Column: Angle

Enter the firing angle for each output.
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Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration
If you have created a new engine configuration on the configuration page Engine — Parameters
using the corresponding button, first the number of outputs corresponding to the number of

cylinders are distributed to the output bank A and output bank B. Selecting the number of outputs

enables access to the fields for the configuration of the outputs. We recommend that you

distribute the number of outputs evenly among the output banks and allocate the larger number to

the A output bank if the number is uneven.

By default, the ignition outputs are distributed so that cylinder 1 of the firing order is always
allocated to output bank A with a firing angle of 0°. The further distribution is implemented by
alternating between output bank A and B. The firing angle for each output results from the
addition of the firing interval to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged.

The allocation of outputs on the output banks to contacts of the output connector of the device
and the cylinders is determined by the wiring. The user must take the wiring into account during
the configuration; it cannot be checked by the software.

Interval between two ignitions

. The interval between two ignitions on one output bank must be at least
1 1.7 ms. During the check, the configured overspeed is used in the
calculation.

NOTICE
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8.11.4 Engine — Ignition Coils
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Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MIC4.)

Only use measured ignition coils

i To operate the MIC4, only ignition coil types measured by MOTORTECH

may be used. All ignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and
NOTICE also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MIC4 is currently
not used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each individual
cylinder. This allows, for instance, different cable lengths on the engine to be compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You can
adjust the secondary voltage estimation while the engine is running in the runtime adjustments
(refer to Runtime Adjustments — Secondary Voltage Calibration on page 144).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can adjust
the secondary short detection in the runtime adjustments while the engine is running (refer to
Runtime Adjustments — Secondary Short Calibration on page 145).

Secondary Short Enable Voltage
Set the average ignition voltage required to activate the secondary short-circuit monitoring:

— The secondary short detection is always activated at a value of 0 kV.
— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.
— The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups
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Active pickups
-4 Check when using active pickups that the auxiliary supply voltage is
1 configured in accordance with your application.

NOTICE

Pickup Setup Information

The settings made in the section Pickup Setup were summarized once again in the section Pickup
Setup Information.
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Pickup Setup
In this area, make the following settings:

Predefined Setup
Select the pickup configuration suitable for your application from the list. The configurations
available for selection depend on the previously entered settings.

Index/Reset Position
Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.
Pickup Sensitivity
Open the pick list and select the desired sensitivity level for the pickup. This setting
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined
pickup setup.
— High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

—  Medium
Default setting for MICT. This is a trade-off between start-up speed and sensitivity.

- Low
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

Trigger/Cam No. of Triggers
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

User-defined

Staff authorized to access the Advanced Service level can, in addition to the standard settings
access, use a manual setup option by clicking on the button User-defined.

™! Pickup Setup x
Pickup Inputs.
Input Type Number 6f Events Speed Active/Passive | Pre-Trigger [V]
PidupInput 1 (Camk  SINGLE EVENT x| o CAMSHAFT = |activehigh * 2.5 $
Pickup Input 2 (Resetk  SINGLE EVENT ~| o CRANKSHAFT ~* passve T 15 =
Pickup Input 3 (Trigger): N - | 160 CRANKSHAFT = passve = 15 S
o ) con

Tigger Disc Type, Default = NONE
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98

Type

You can select the type of events that will occur on this input for each pickup input. Type
and number of events are defined by the discs or ring gears used. If you decide not to use
a pickup input, select the entry None from the list. You can set the following types:

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a ring
gear with 160 teeth (N=160).

N+

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth for
the index signal (N=12).

N+1 Extended Index Range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded to
75 % of the tooth period. An incorrect direction of rotation of the engine cannot be
detected by this setting.

N-1

Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal

N-2

Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Single Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that can
be analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.

The number of events must lie between 3 and 500. Additionally, it must be taken into
account that the sum of the frequencies at the pickup input does not exceed the limit of 10
kHz at the pre-set overspeed.

Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.

Active/Passive

Select the pickup to be used from the pre-defined pick list:
Passive

passive pickup

Active (low)

active pickup with high level as quiescent level

Active (high)

active pickup with low level as quiescent level
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— Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity. Signals
that fall short of the set voltage will not be analyzed. A low pre-set value therefore results
in a high sensitivity level, a high value results in a low sensitivity level.

Pickup setup information

-4 The respective latest setting in the area of the pre-defined or arbitrary

pickup settings is transferred to and displayed under Pickup Setup
Information.

|

NOTICE

Auxiliary Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24V is possible.

Speed Settings
In this area, make the following settings:

Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall not
exceed 1/7 of the nominal speed.

Security Speed

Enter the security speed. Below the value entered, the ignition can be switched on and off as
desired. If the ignition is deactivated during operation above the set speed, the ignition cannot
be immediately reactivated. Only when the ignition no longer reads a speed, i.e., the engine
has come to a standstill, can the ignition be reactivated.

Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

Overspeed

Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.

Max. Power-on Speed

Enter the maximum permitted start speed at which the MIC4 starts sending ignition pulses.

A value of 6000 rpm is set as the default value: The MIC4 can be activated at the starter speed
and immediately send ignition pulses.

For a value of 0 rom the MIC4 can only start sending ignition pulses once it has registered that
the engine is at a standstill.
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8.11.6 Timing — Analog Inputs
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& COMS IDMIC4 4x2.16 (1.5.1 [0000c801]) ADV. SERVICE Full Access Version: 2.48.0

Auxiliary supply voltage
-4 Check with the configuration of the analog inputs, that the set auxiliary
1 supply voltage corresponds to your application.

NOTICE

Analog Inputs Base Settings
The ignition timing adjustment can be made using two analog input signals, which can be set
within the following limits:

— Analog current signal: 0-20 mA

— Analog voltage signal: 0-10 V
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Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state > 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on

page 101.

Aux. Analog Input Supply Voltage
An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value between

5Vand24V.

8.11.7 Timing — Schedule A/B — General
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Schedule A General Settings

The MIC4 offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured,
the switch is ignored. The configuration options for schedule B are identical to those for set A.

— Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits

Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs
will be limited to this range relative to the respective top dead center of the pertinent cylinder. The
global timing can then not be shifted beyond this range by any adjustments.

Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits entered
and is a static portion of the global timing.

Potentiometer Function

The checkbox enables and disables the potentiometer function for manually adjusting the global
timing by the respective stops of the potentiometer set, depending on the direction of rotation. If
the potentiometer is subsequently disabled once again, the system will no longer access the data
during the following data transfer to the device and restart of the engine, and the device will no
longer use this data to calculate the global ignition timing.

Analog Current Input/Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input signal.
An error value can be entered for the signals if a failure threshold has been defined for the
corresponding input in the window Timing — Analog Inputs. If the signal is below the failure
threshold, the timing is offset by the error value. The adjustment remains until the signal again
exceeds the threshold to reset the error state (see Timing — Analog Inputs on page 100).

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things, the
adjustment possibility in the window Cylinder Individual Offset. In addition the limits also apply to
the corresponding adjustment signals from all other sources, for example via the fieldbuses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from the
list, the corresponding number of fields is activated for input.

The first speed point is always set to 0 RPM. All other timing points are assigned with the value by
which the signal is to be offset when the respective speed is reached. For the last speed point, the
timing of the nominal speed should be entered. Please note that the speed points must always be
entered in ascending order.
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8.11.8 Timing — Schedule A/B — Energy
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You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you only
want to use one criterion, set the other value to 0. If you do not want to define any start-up phase,
set both values to 0.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

Required supply voltage for energy control

. Depending on the output configuration and the energy settings, for a
1 correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
NOTICE the required supply voltage is displayed in a notice in the window Timing

— Schedule A/B — Energy.

8.11.9 Timing — Miscellaneous
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You can specify how fast the changes of the timing should be executed.
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— Maximum Firing Angle Change Per Cycle
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment is
larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms
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The MIC4 ignition controllers include a total of 16 configurable alarms that can be allocated to the
general purpose outputs.

— Description

You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.

- Function
The alarms can be used depending on the following functions:

—  Unused

— Speed above threshold / below threshold

— Engine operating hours above threshold / below threshold

— Spark plug operating hours above threshold / below threshold
— Warning active
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— Erroractive

— Temperature above threshold/below threshold

— Analog voltage input over threshold/under threshold

— Analog current input over threshold/under threshold

— Global ignition timing above the threshold/below the threshold

— Supply voltage above threshold/below threshold

— Min. spark duration above threshold/below threshold

— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) above threshold

— Consecutive misfires (primary, single output) above threshold

— Misfire rate (secondary, individual output) above threshold

— Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold

— Consecutive misfires (secondary, single output) over the limit
— Threshold

Input of desired threshold value.

— Hysteresis
Input of desired hysteresis value.

- Delay
Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

— Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered. The
shutdown causes an operational error. Therefore the checkbox should not be checked, if the
alarm Error active is selected.

— Permanent — Keep output activated until alarm is acknowledged
If this box is checked, the output remains permanently active until the alarm is acknowledged.
If the box is not checked, the output remains active only for as long as the alarm is active.

- Log Events
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.

—  Outputs
Activate the checkbox GPOT1, so that the general purpose output is activated when the alarm is
triggered.

- GPO Settings
Configure the general purpose output as normally closed or normally open.
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8.11.11 Inputs/Outputs — ASO1 (Auxiliary Synchronization Output)
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With the auxiliary synchronization output, freely definable impulses depending on the angle of the
crankshaft can be generated. For the output, the user defines whether the angle will be absolute
or based on the global timing. The output can generate between 1and 16 impulses and only be
assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 67.

— No. of Points
Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 pys synchronous with the first
cylinder in the ignition sequence. You can get this setting via the button Configure for
DetCon2/20.

- Angle Reference
Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps. This setting also
determines when ASO signals are generated. For this, also read the information box ASO
signals depending on the ignition release.
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- Mode

Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
>
t2 13
High — “—
- r »
*)
Low

°crankshaft

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
ry

High

Low

A 4 !F A 4

“crankshaft

*) active edge marks the configured engine rotation angle

|

NOTICE

|

NOTICE
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Maximum impulse duration

Please note that the duration of the impulse can be entered as max.
300 ps. Input of higher values will not be accepted by the system.

ASO signals depending on the ignition release

The setting in the drop down list Angle Reference determines when ASO
signals are generated:

— Actual Angles Depending on Global Timing
ASO pulses are only transmitted if ignition is active, indicated by the
green status display Firing Active in the window Runtime Data —
Overview.

— Absolute Timing
ASO pulses are generated independently of the ignition release as
soon as the synchronization of the pickups is accomplished.
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8.11.12 Inputs/Outputs — Inputs

M unnamed.micd® (MICA 4x2.16) - MICT - ] b4

Eile Device 3ettings Document JTools Help

LI R RY =11 e

Configuration Page Input Settings
~ |Engine GPI Settings
L] Parameters GPI1: CANreset (1spulse), device reset (5 s pulse) v

7 Cylinder Names
| Ignition Qutputs

Igniticn Coils
B Pickups
~ Timing

J

Analog Inputs
~ [T Schedule A
7 General
| Energy
~ [} Schedule B
" General
7 Energy

17 Miscellaneous

“ Inputs/Qutputs
) Alarms
=

ASO1
v Miscellaneous
| Communicaticn

[ Information

& COMS IDMIC4 4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2480

Various functions can be selected for the general purpose input GPI1:

Rev. 01/2026

Disabled
The input GPI1 will not be used.

CAN reset (1s pulse), device reset (5 s pulse)

This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver
and a high impulse of 5 seconds leads to a device reset.

Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high), device reset
(>15 s high)

This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed
and/or device reset to be triggered externally using a high impulse. If the high impulse is
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than
3 seconds, all errors and alarms will be confirmed. If the high level lasts for more than

15 seconds, this triggers a device reset.
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8.11.13 Miscellaneous — Communication

M unnamed.micd® (MICA 4x2.16) - MICT - ] X

Eile Device 3ettings Document JTools Help

L VIR Y =11 e

‘Communication

Configuration Page
can

kg Engi_ne
| Parameters CAN tode CANOper S8 RuR.
| Cylinder Names O ALL-IN-ONE (11939) CANopen Node ID: 30 =)
7 Ignition Outputs O 11939
| Ignitien Coils © CANopen
1] Pickups

~ Timing
=Y

Bitrate: | 250 kbit/s >

Analog Inputs
~ [T Schedule A
7 General
| Energy
~ 1] Schedule B
" General
7 Energy
OIrsass
L] Miscellaneous
v Inputs/Qutputs RS485 Mode RS485 Settings
1 Alarms Modbus Bitrate: 9600 bit/s -
[ ason
I Inputs
v Miscellaneous
e

] Information

Parity: even -

Stop Bits: 1 -

Modbus Address: 1 -

Mode: rtu &

@ COMS IDMIC4 4x2.16 (1.5.1 [0000c801]) ADV.SERVICE Full Access Version: 2480

CAN
Clicking on the CAN checkbox enables or disables the CAN interface on the device.

ALL-IN-ONE (J1939)/J1939/CANopen

Select the desired protocol, depending on whether you want to set the communication for the
ALL-IN-ONE or for another device. For example, for a connection to the PowerView3, select
CANopen.

J1939 Settings

The J1939 source address can be assigned between 0 and 253. Note that IDs cannot be
assigned more than once. The Address Filter can be used to set that broadcast PGNs are only
accepted from one or two specific source addresses you have entered. If the filter is
deactivated, the broadcast PGNs are accepted from all source addresses.

CANopen Settings
The CANopen node ID can be assigned between 1and 127. Note that IDs cannot be assigned
more than once.

Baudrate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s.

110 Rev. 01/2026



8 Settings via the MICT

RS485
Clicking on the field RS485 enables or disables the Modbus interface on the device.

Baudrate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s.

Parity
Define if a parity bit is used and if the parity is to be even or odd.

Stopbits

Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity has

been selected.

Modbus Address

The Modbus address can be assigned between 1and 247. Note that IDs cannot be assigned
more than once.

Mode

Define if the data are transferred in the ASCIl or RTU mode.

Setting the transfer rate

Note that all devices connected with a bus must be set to the same

1 transfer rate.

NOTICE

Information on protocols

-4 Please contact your MOTORTECH contact person if you require more
1 information on the CANopen®, J1939 and Modbus protocols.
NOTICE

Rev. 01/2026

m



8 Settings via the MICT

8.11.14 Miscellaneous - Information

This configuration page can be viewed by all users, but changes can only be made with
authorization for the Service access level.

M unnamed.micd” (MIC4 4x2.16) - MICT

Eile Device 3Settings Document Tools

Configuration Page
~ Engine

{1 Parameters
Cylinder Names
I} Ignition Outputs

Ignition Ceils

Pickups

Analog Inputs
~ [ Schedule A
General

1 Energy
Schedule B
| General

) Energy
_\ Miscellaneous
~ Inputs/Outputs
[ Alarms
AsO1
L Inputs
v |Miscellaneous

" Communication

Site and Module

Help

Information
Site and Module

Site Description:

Site Location:

HAESHS IS BOEE C

Module Description:
Engine Type Desciption:

Service Contact

Contact Information §.e. company, name, phone, e-mall):

& COMS ID MICA 4x2.16 (1.5.1 [0000c801]) ADV. SERVICE Full Access Version: 2.48.0 i

In this section, enter information on the system and the module for which the configuration will be

used.

Service Contact

In this section, individual contact data can be saved that can be called up and displayed via MICT.

12
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8.12 Runtime Data
Click on the symbol to open the window Runtime Data. The following sections will
give you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposal in the toolbar in the window:

Symbol Function

Prints the runtime data.

Prints the runtime data to a PDF file.

Opens the print preview.

@

Starts the runtime data trace.

Stops the runtime data trace.

=0

i |

S Acknowledges operational errors. If an operational error is acknowledged, all
‘ (@' alarms are also simultaneously acknowledged. The symbol is grayed out if no

acknowledgeable error is present.

Save runtime data locally

i You should always save runtime data on the local computer and not on a

network drive or an external storage device. Trace files can only be
moved freely once the recording is stopped.

NOTICE

Displaying older runtime data files

[ ] e . .
Due to modifications on the message lists, recorded errors, warnings and

1 alarms of older runtime data files can be missing when they are displayed
in the current version of the MICT.

NOTICE

Runtime data files that were recorded under the following conditions are
affected:

— MICT version prior to 1.31.x and
— Firmware version 0.14.4 or older

Rev. 01/2026 13
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8.12.1 Runtime Data — Overview

M MICT - Runtime Data - O b4

FHH o -

Overview  Timing  Igniton  BankA  States  Messagelog  Diagnostics  Temperatures  Information

Speed Device State
D idle D Configuration
D Synchronizing D SeltTest
(D Firing Active
) Firing Locked
) Wait for Stop ) Start Phase
(@] Warmning D Alarm
@ Error
Control
) Firing Enabled
D Schedule A
@ ePi
Speed RPM
I -
@ GrO1
Failure
@ Analog Current Input () Analog Voltage Input
@ Ignition Qutput
Timing Misfire Rate
Global Timing Point [l eToc Primary Secondary
singe Owpot [N >+ N
Operating Hours
S anoupus JIERE o [ %
park Plugs NN
s s
engine [N S o

D COM4 1D MICA 4x1.08 (1.5.1 (00002801))  Lifetime: 43:40:50.965

You can find the following information in the window:
— Speed Indicator (analog)

— Red pointer
Displays the current registered speed

—  Yellow pointer
Displays the maximum registered speed since last starting the engine

— Green pointer
Display of set overspeed
— Speed Indicator (digital)
Digitally displays the current speed

— Global Timing Point
Digital indication of the current global timing
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8 Settings via the MICT

— Operating Hours
— Spark Plugs
Indicates the current operating hours of the spark plugs
- Engine
Indication of current operating hours of the engine
— Device State
The status of the device is shown by the following status displays:

Device status Description

Idle The ignition is ready and waiting for pickup activity.

Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is not
released.

Wait for Stop Pickup signals are being received, the ignition fired above the

security speed, and the ignition release was retracted. The
engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self test is running (refer to Self Test on page 77).

Start Phase The engine is in the configured start phase (refer to section
Timing — Schedule A/B — Energy on page 103).

Warning A warning has occurred (see section Warnings on page 130).

Error An error has occurred (see section Errors on page 131).

Alarm A configured alarm has occurred (see section Alarms on page
131).

— Control

— Firing Enabled
The green status display signals that the firing is active.

— Schedule A/B
The green status display shows which parameter settings are currently used.

'(I%E:status display shows the status of the input signal.
— Output
- GPO1
The general purpose output is switched on with the green status display.
— Failure

— Analog Current Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again gray.
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116

Analog Voltage Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again gray.
Ignition Output

The red status display signals a current misfire on at least one output. With a yellow

status display at least one misfire has occurred at one output since the last reset of the
counter.

Misfire Rate

The misfire rate is displayed for the primary side and secondary side. The misfire rate on the
secondary side is only displayed if the secondary side diagnosis is activated (refer to section
Engine — Ignition Coils on page 94).

Single Output
Displays the misfire rate of the output for which the most misfires were registered during
the last 32 cycles.

All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

The number of misfires per second are calculated by the MIC4 as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM /60 / 2
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8.12.2 Runtime Data — Timing
B! MICT - Runtime Data = (=] x
PEHN 0B

Overview  Timing  Igniton  BankA  States  Messagelog  Diagnostics  Temperatures  Information
Global Timing Point Calculation

Base Timing + - BTDC

Potentiometer Timing + - RET _ % ﬁ
Analog Cument input Timing + [ JEENEN ~ov DR -~ O

Speed Curve Correction + - RET

Timing Correction + - RET

Global Timing Point  [JHlEN 8T0C
Individual Timing

vinimom [N TOC

Maximum - BTDC
Average - BTDC

*

Analeg Voltage Input Timing

D COM4 1D MICA 4x1.08 (1.5.1 (00002801))  Lifetime: 43:40:50.965

In this view, the system displays all values and settings in the left hand section that influence the
timing. On the right, the current input values (e. g. potentiometer, analog current and voltage
input), leading to the displayed timing adjustment, are displayed numerically and in bar charts. The
value for the speed curve is shown by curve progression set in the configuration. Refer to the
section Timing — Schedule A/B — General on page 101. The timing correction can be implemented
for the runtime. Refer to the section Runtime Adjustments — Timing on page 142.

In the lower range, the maximum, minimum and average of the cylinder individual offsets are also
displayed.
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8.12.3 Runtime Data - Ignition
M MICT - Runtime Data - O X
PEHN DB

Overview  Timing  Ignition Bank A  States  Messagelog  Diagnostics  Temperatures  Information
Estimated

Qutput Cylinder Secondary Valtage [KV] Misfire
oo Nl S —— 0
R e T N WA T
A3 3- ;l_I:’l T 3la T 4|0 T 5|° Q
I e S S N
A5 2- ‘;.T 3lo T 4:] T 5:] Q
o TEER T ) O
o ol T — 0

=
1]
8
]
v

Coll Data Version: 1

D COM4 1D MICA 4x1.08 (1.5.1 (00002801))  Lifetime: 43:40:50.965

The following information is provided:

—  Column: Output
Designation of the output

— Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Estimated Secondary Voltage [kV]
Secondary voltage determined by the ignition controller of the respective output.
The secondary voltage is used to determine deviations between the individual outputs. These
indicate a possible problem at this output (e. g. problems in the area of the spark plug or the
cylinder).
If you have set the ignition coils (refer to Engine — Ignition Coils on page 94) for which a
secondary voltage estimate does not seem possible "---" appears.
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Column: Misfire

4

RTECH®

1

The red status display signals a current misfire at the respective output. With a yellow status

display at least one misfire has occurred at the respective output since the last reset of the

counter.

The coil data version configured in the MIC4 is displayed under the ignition runtime data.

8.12.4 Runtime Data — Bank A and B

M MICT - Runtime Data

T

(AL

R
%)

HHHA e =

Overview ~ Tming  Igniton ~ BankA  States  Messagelog  Diagnostics  Temperatures  Information

open short Rate [%] open short Rate [%]

ROt Gt ['ﬁgf:k] i [:;] oi'.?ﬁﬁ”m] Enimaty] = &
A SHEE DEEENH EEE o o HH o
2 < EEE EE o o HE o
~  CENEE DEEEEH EEW o o HE o
«  EEEN] DEEEEH B o o HE o
s NN I EE o o HH o
o N EEE EE o o HH o
a il IEEE Bl o o HE o
o HEEE I EE o o Ml o

Show Firing Angles: (O Relative (@) Absolute

D COM4 1D MICA 4x1.08 (1.5.1 (00002801))  Lifetime: 43:40:50.965

he following information is provided:

Column: Output

Designation of the output

Column: Cylinder

If cylinder names are assigned, these are displayed.
Column: Angle

Current output firing angle

Column: Min. Spark Duration
Minimum spark duration of the outputs

Rev. 01/2026
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8 Settings via the MICT

— Column: Energy Output
Current energy release of the output

— Columns: Misfire
Status display for the different types of misfires (primary, secondary, open, short circuit). In
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow
status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-> Send command ->
Reset misfire counters. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

— Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.

8.12.5 Runtime Data — States

M MICT - Runtime Data - [m] X

FRHA G

Overview  Timing  Igniton  BankA  States  Messagelog  Diagnostics = Temperatures  Information

Operating Hours  Time Status Message
48:11:27.848  2021-07-14 10:36:39 PUT: Operational error.
48:11:27.848  2021-07-14 10:36:39 PU1: Number of events (5) counted on pickup input PU1 does not match

@ COM4 1D MIC4 4x1.08 (1.5.1 [00002801]) Lifetime: 49:40:50.965

Status messages are listed in the States view.
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The following information is provided:
— Operating Hours
Operating hours counter reading at the time of message
- Time
Date and time of the message (see following information box)
— Status Message
Message text

Date and time of ignition controller

. The date and time can be individually configured for each ignition

controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur

1

NOTICE between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time
in the menu via Device -> Set date and time.

Status messages are displayed in black if they are current. If a status is reset, the status message
is displayed gray for 10 seconds before it is deleted from the list.

The following status messages can be displayed:

Status message Description

Alarm shutdown caused by alarm The engine was shut down by an alarm, as the configured

number. limit was exceeded or not reached. You can view the alarm
number in the configuration (see Inputs/Outputs — Alarms
on page 105).

Analog current input failure Failure threshold set for analog current input was

(current: x mA, failure threshold: undershot (see Timing — Analog Inputs on page 100).

y mA, failure reset threshold: The following values were obtained: Current: x mA, failure

Z mA). threshold: y mA, threshold for failure reset: z mA.

Analog voltage input failure Failure threshold set for analog voltage input was

(voltage: x V, failure threshold: y V, undershot (see Timing — Analog Inputs on page 100).

failure reset threshold: z V). The following values were obtained: Voltage: x V, failure
threshold: y V, threshold for failure reset: z V.

Aux analog input supply voltage Error in auxiliary supply voltage of analog inputs (see

failure (voltage: u V, desired Timing — Analog Inputs on page 100). The following values

voltage: v V, failure threshold: x V, were obtained: Voltage: u V, expected voltage: v V, failure

failure reset threshold: y V). threshold: x V, threshold for failure reset: y V
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Status message

Aux pickup supply voltage failure
(voltage: u V, desired voltage: v V,
failure threshold: x V, failure reset
threshold: y V).

Configuration data checksum
error. Using default configuration.

Configuration invalid. Using
previous configuration.

Current sensor of output bank
name failed.

Cylinder individual timing limited to

range timing 1.. timing 2

Device started after supply voltage

failure.

General error number.

Global timing x° crankshaft limited
to range y° crankshaft .. z°
crankshaft.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Output board identification failed
due to a checksum error.

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.

122

Description

Error in auxiliary supply voltage of pickup (see Engine —
Pickups on page 96). The following values were obtained:
Voltage: u V, expected voltage: v V, failure threshold: x V,
threshold for failure reset: y V

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device again.

The configuration is invalid. The previous configuration is
used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device again.

The current sensor of output bank name failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.

The cylinder-individual offset has reached the set limit
(Timing 1... Timing 2 (see Timing — Schedule A/B — General
on page 101).

The device was started after a failure of the supply
voltage. If applicable, check the power supply to the
device.

General error number. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The global timing (x° crankshaft) is located outside the
configured limits (y° crankshaft .. z° crankshaft; see Timing
— Schedule A/B — General on page 101).

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

The identification of the output board failed due to a
checksum error. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to missing
data. Restart the device. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Status message

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Pickup configuration invalid.

Power failure detected on output
Anumber/Bnumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded limit
(y W) at a supply voltage of z V.

The power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

PUnumber: Faulty index.

PUnumber: Faulty Signal. Signal
period (x, events counted y) is too
small compared to previous signal
period (2).

Rev. 01/2026

Description

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

Power supply fault in output board caused by output
Anumber/Bnumber. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V. Increase the supply voltage and
check the energy settings (see Timing — Schedule A/B -
Energy on page 103).

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of

z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page
103).

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of
z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page
103).

The pickup PUnumber has an error in index. Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 96). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 159.

The pickup (PUnumber) is supplying a faulty signal. Signal
period (x, events counted y) is too small compared to
previous signal period (z). Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.
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Status message

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal. Signal
period (x, events counted y) is too
great compared to previous signal
period (2).

PUnumber: Missing Signal. Signal
timeout occurred (events counted
X).

PUnumber: No index mark found.

PUnumber: No signal.

PUnumber: Number of events (x)
counted on pickup input
PUnumber does not the match the
expected value (y).

PUnumber: Operational error.
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Description

Index mark missing for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 96). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 159.

Index missing for pickup (PUnumber). Check the pickups
and the corresponding configuration (see Engine —
Pickups on page 96). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 159.

Signal missing for pickup (PUnumber). Signal period (x,
events counted y) is too large compared to previous signal
period (z). Check the pickups and the corresponding
configuration (see Engine — Pickups on page 96).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 159.

Signal missing for pickup (PUnumber). Timeout occurred
(events counted until timeout x). Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.

Could not find index mark for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.

The pickup (PUnumber) is not supplying a signal. Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.

For the pickup (PUnumber) the number of events (x)
counted on pickup input number does not the match the
expected value (y). Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.

An operational error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.
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Status message

PUnumber: Polarity detection
failed.

PUnumber: Synchronization
problem.

PUnumber: Wrong pickup signal
polarity on pickup input PUnumber
detected. Reversing polarity
internally.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Temperature of device (x °C)
exceeded error threshold limit
(y °C).

Temperature of device (x °C)
exceeded limit (y °C).

Temperature of device (x °C)
exceeded permanent limit (y °C).

Temperature sensor failed.

Rev. 01/2026

Description

Polarity detection failed for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 96). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 159.

A synchronization error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.

Wrong polarity of pickup (PUnumber) detected at pickup
input PUnumber. Reversing polarity internally. No
additional action required.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 77).

Potential causes:

— Interference coupling on pickup signal
— Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 96).
The reason for this may also be an interference coupling
on the trigger signal.

The temperature of the device (x °C) exceeded the failure
threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.

The temperature of the device (x °C) exceeded the
warning threshold limit (y °C) for more than two minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature of the device (x °C) exceeded the
warning threshold limit (y °C) for more than ten minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor has failed. Restart the device. If
the error occurs again after restarting the device, please
contact MOTORTECH.
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8.12.6 Runtime Data — Message Log

M MICT - Runtime Data - O b4

FHHA -

Overview  Timing  Igniton  BankA  States  Messagelog  Diagnostics = Temperatures  Information

Qperating Hours  Time Category Message &)

43:51:27.974  2021-07-06 09:10:50  Info  J1939 on interface CAN1 changed state to "Enter”,
43:51:28.234  2021-07-06 08:10:51 Info  J1939 on interface CAN1 changed state to “Start succeeded
43:56:03.913  2021-07-06 03:15:26 Infe  Configuration changed.

43:36:03.916 2021-07-06 03:15:26  Alarm Al alarms reset.

44:41:41.210  2021-07-06 10:01:04  Info  Device switched off.

44:41:42.473  2021-07-06 10:3310  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
44:41:42.474  2021-07-06 10:33:10  Info  J1939 on interface CANI changed state to "Enter”.
44:41:42.734  2021-07-06 10:33:10  Info  J1939 on interface CAN1 changed state to "Rart succeeded
46:22:38.642  2021-07-06 12:14:07  Info  Device switched off,

46:22:39.905 2021-07-07 02:45:08  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
46:22:39.906 2021-07-07 08:45: Info  J1939 on interface CANT changed state to "Enter”.
46:22:40.166  2021-07-07 Info  J1939 on interface CAN1 changed state to “Start succeeded
46:40:10.416  2021-07-07 Infe  Device switched off.

46:40:11.679  2021-07-07 Info  Device (firmware 1.12.0.40630) started at a supply voltage o
46:40:11.680  2021-07-07 Info 11932 on interface CAN1 changed state to "Enter”,
46:40:11.940  2021-07-07 Info  J1939 on interface CAN1 changed state to “Start succeeded
47:37:20.339  2021-07-07 10:31:38 Info  Device switched off.

4AT:37:21.602 2021-07-13 10:10:32  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
47:37:21.603  2021-07-13 10:10:32 Info 11939 on interface CAN changed state to "Enter”.
47:37:21.863  2021-07-13 10:10:32 Info  J1939 on interface CAN1 changed state to “Qtart succeeded
49:11:15.930  2021-07-13 11:44:27  Info  Self test started.

49:11:39.794  2021-07-13 11:44:30  Info  Self test stopped.

49:35:45.848 2021-07-13 12:08:57  Info  Device switched off.

49:35:47.112  2021-07-14 10:00:58 Infe  Device (firmware 1.12.0.40630) started at a supply voltage o
49:35:47.112  2021-07-14 10:00:58 Info  J1939 on interface CANT changed state to "Enter”.
49:35:47.373  2021-07-14 10:00:58  Info  J1939 on interface CAN1 changed state to “Start succeeded
50:09:54.525 2021-07-14 10:35:06  Info  Firing disabled (Start/Step In: disabled, CAN: n/a, R$485: n/
50:09:55.029 2021-07-14 10:35:06 Infe  Firing enabled (Start/Stop In: enabled, CAN: n/a, RS485: n/a
50:11:27.848  2021-07-14 10:36:39  Error  General error in pickup pre-processing on pickup input PU™
S0:11:27.848  2021-07-14 10:36:39  Error  Operational error caused by pickup signals. PUT = 0x00010(
50:12:48.254 2021-07-14 10:37:59  Info  Operational error acknowledged.

< >

B Automatic scrolling Acknowledge Alarms.

D COM4 1D MICA 4¢1.08 (1.5.1 [0000801)) Lifetime: 50:40:50.965

In the view Message Log, information, warnings, errors and alarms are listed.

Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 105.

Errors and appropriately configured alarms shut down the engine.
The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message (see following information box)

— Category
Type of message (information, warning, error, alarm)

- Message
Message text; you can find more information on the message texts in the following sections.
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You have the following options:

— Automatic scrolling
If this box is checked, the system automatically displays the last list entry until a new event

occurs.

— Acknowledge Alarms
With this button, you can reset triggered alarms if they are no longer active. An alarm can only
be acknowledged if the checkbox Permanent — Keep output activated until alarm is
acknowledged in the alarm configuration is activated.

1

NOTICE

1

NOTICE

|

NOTICE

Rev. 01/2026

Date and time of ignition controller

The date and time can be individually configured for each ignition
controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur
between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time
in the menu via Device -> Set date and time.

Acknowledging an operational error

While the engine is in standstill, there are the following options for
acknowledging operational errors:

— ViaDevice -> Send Command -> Acknowledge Operational Error in
the MICT

— Restart/ Reset
— Hold button PB on the controller longer than three seconds

Acknowledging warnings

You can acknowledge a warning by briefly pressing the pushbutton PB on
the controller.
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8 Settings via the MICT

Displaying older runtime data files

) Due to modifications on the message lists, recorded errors, warnings and
1 alarms of older runtime data files can be missing when they are displayed
in the current version of the MICT.
NOTICE

affected:

Runtime data files that were recorded under the following conditions are

—  MICT version prior to 1.31.x and

— Firmware version 0.14.4 or older

8.12.6.1 Information
Information

Access control disabled.

Access control enabled.

All access control PINs reset.

CAN interface CANnumber entered
bus off state.

CAN interface CANnumber left bus
off state.

CAN reset requested by
GPlnumber.

CANopen on interface CANnumber
changed state to "name".

Configuration changed.

Date and time set.

Device (firmware
number.number.number.number)
started at a supply voltage of x V.

Device reset requested by
GPlnumber failed because pickup
signals have been detected.

Device switched off.
Engine operating hours set to x h.

Failed to change PIN of access
control level "number".

128

Description

The Access control was disabled (see Access Control for
MIC4 on page 81).

The Access control was enabled (see Access Control for
MIC4 on page 81).

All PINs for access control were reset (see Access Control
for MIC4 on page 81).

The CAN interface CANnumber has entered Bus off state
(see Runtime Data — Diagnostics on page 135).

The CAN interface CANnumber has left the Bus off state
(see Runtime Data — Diagnostics on page 135).

A CAN reset was requested via general purpose input
GPInumber (see Inputs/Outputs — Inputs on page 109).

The CANopen at interface CANnumber has changed state
to "name" (state of NMT State Machine according to CiA
DS 301).

The configuration of the device was changed (via MICT or
via fieldbus).

The date and the time have been set.

The device (firmware number.number.number.number)
was started with a supply voltage of x V.

The device reset requested by GPInumber failed because
pickup signals have been detected (see Inputs/Outputs —
Inputs on page 109).

The device was switched off.
The engine operating hours set to x h.

Failed to change PIN of access control level "number" (see
Access Control for MIC4 on page 81).
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Information

Failed to disable access control.

Failed to enable access control.

Failed to reset all access control
PINs.

Firing disabled (Start/Stop In:
value, CAN: value, RS485: value)

Firing enabled (Start/Stop In: value,
CAN: value, RS485: value)

J1939 on interface CANnumber
changed state to "name".

One or more messages are lost due
to exhausted memory pool or
message queue overrun.

Operational error acknowledged.

PIN of access control level
"number" changed.

Self test denied because no
outputs are configured.

Self test started.

Rev. 01/2026

Description

The access control could not be disabled (see Access
Control for MIC4 on page 81).

The access control could not be enabled (see Access
Control for MIC4 on page 81).

Failed to reset all PINs for access control (see Access
Control for MIC4 on page 81).

The firing is disabled, because at least one of the inputs
(start/stop input, CAN interface, RS485 interface) used for
the firing release is disabled. The inputs can have the
following values:

— enabled: Firing enabled

— disabled: Firing disabled

— n/a:not used

The firing is enabled, because all inputs (start/stop input,
CAN interface, RS485 interface) used for the firing release
are enabled. The inputs can have the following values:

— enabled: Firing enabled

— disabled: Firing disabled

— n/a:not used

J1939 on interface CANnumber changed state to "name".
Following statuses are possible:

— Enter/Start succeeded
The CAN mode J1939 or ALL-IN-ONE (J1939) was
started.

—  Start failed
Initialization failed.

- Stop
Assignment of the Source Address was unsuccessful.
A different source address needs to be set in the
configuration (see Miscellaneous — Communication on
page 110).

- Leave
Left CAN mode J1939 or ALL-IN-ONE (J1939).

One or more messages were lost because there was
insufficient storage space or too many messages were
queued.

Operational errors are acknowledged.

PIN of access control level "number" changed (see Access
Control for MIC4 on page 81).

The self test could not be carried out because no outputs
are configured (see Self Test on page 77).

The self test was started (see Self Test on page 77).
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Information
Self test stopped.

Spark plug operating hours set to
x h.

Speed (x RPM) exceeded maximum
allowed speed (yRPM) at power-
on. Waiting for engine stop.

Wrong pickup signal polarity on
pickup input PUnumber detected.
Reversing polarity internally.

8.12.6.2 Warnings

Description
The self test was stopped (see Self Test on page 77).

The spark plug operating hours were set to x h.

Speed (x RPM) has exceeded the maximum speed (y RPM)
during operation. The ignition controller is waiting for the
engine to stop.

Wrong pickup polarity detected at pickup input PUnumber.
Reversing polarity internally.

Contrary to errors, warnings do not result in the engine being shut down.

Warning

Configuration data checksum error.

Using default configuration.

Configuration invalid. Using
previous configuration.

Disable secondary diagnostic due
to output Anumber/Bnumber.

General warning number.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Invalid coil data received.

Pickup configuration invalid.
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Description

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade of the firmware. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

The configuration is invalid. The previous configuration is
used. This message may appear during an
upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device again.

Secondary diagnosis disabled due to output
Anumber/Bnumber shut off. Check the ignition coil and
wiring at the corresponding output.

General warning number. An undefined warning has
occurred. If this occurs repeatedly, please contact
MOTORTECH.

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

Invalid coil data received. This message may appear during
an upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device again.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.
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Warning

Power output (x W) exceeded limit
(y W) at a supply voltage of z V.

Speed (x RPM) exceeded
overspeed limit (y RPM). Previous
speed was z RPM.

Temperature of device (x °C)
exceeded limit (y °C)

8.12.6.3 Alarms

Description

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of
zV.

Speed (x RPM) exceeded overspeed limit (y RPM).
Previous speed was z RPM (see Engine — Pickups on page
96). The reason for this may also be an interference
coupling on the trigger signal.

The temperature of the device (x °C) exceeded warning
threshold limit (y °C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.

Alarms can be defined in the configuration. When doing so, each alarm is assigned a number (see
Inputs/Outputs — Alarms on page 105).

Alarm

Alarm number "description"
acknowledged.

Alarm number "description"
triggered.

All alarms reset.

8.12.6.4 Errors

Description

The alarm number "description" was acknowledged.

The alarm number "description" was triggered.

All alarms reset.

All system or operational errors cause the engine to be shut down.

Error
Alarm shutdown caused by alarm
number.

Assertion failed (x).

Critical error x (y).

Current sensor of output bank
name failed.

Rev. 01/2026

Description

The engine was shut down by alarm number. This function
was defined in the configuration (see Inputs/Outputs —
Alarms on page 105).

An assertion was not adhered to (x). For example, an
assumption about a value was not fulfilled in the firmware.
If the error occurs again after restarting the device, please
contact MOTORTECH.

Critical error x (y). If the error occurs again after restarting
the device, please contact MOTORTECH.

The current sensor of output bank name failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.
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Error

Cycle signal was missing, so more
trigger signals were counted than
available per cycle.

Device started after supply voltage
failure.

General error number.

General error in pickup pre-
processing on pickup input
PUnumber.

Number of trigger signals (number)
counted does not match the
configured value.

Operational error caused by pickup
signals. PU1=x, PU2 =y, PU3 =2Z.

Output board identification failed
due to a checksum error.

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.
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Description

Cycle signal was missing, so more trigger signals were
counted than available per cycle. Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.

The device was started after a failure of the supply
voltage. If applicable, check the power supply to the
device.

General error number. An undefined error has occurred.
Restart the device. If the error occurs again after restarting
the device, please contact MOTORTECH.

General error in pickup pre-processing on pickup input
PUnumber. Check the pickups and the corresponding
configuration (see Engine — Pickups on page 96).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 159.

Number of trigger signals (number) counted does not
match the configured value. Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.

An operational error was caused by pickup signals (pickup
PU1 = x, pickup PU2 =y, pickup PU3 = 2).

For information on the numbers shown, please consult the
documentation on the pickup status bits on the storage

device enclosed with the ignition controller. You can open
the file via the menu: Documentation -> More information.

Check the pickups and the corresponding configuration
(see Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.

The identification of the output board failed due to a
checksum error. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to missing
data. Restart the device. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Error

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Power failure detected on output
Anumber/Bnumber.

Power output (x W) exceeded error

threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Supply voltage failure.

Temperature of controller board
(x °C) exceeded limit (y °C).

Temperature of device (x °C)
exceeded error threshold limit
(y °C).

Rev. 01/2026

Description

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

Power supply fault in output board caused by output
Anumber/Bnumber. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V.

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of
zV.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 77).

Potential causes:

— Interference coupling on pickup signal

- Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 96).
The reason for this may also be an interference coupling
on the trigger signal.

Supply voltage failure. If applicable, check the power
supply to the device.

The temperature of controller board (x °C) exceeded limit
(y° C). Ensure that there is sufficient air circulation and/or
cooling.

The temperature of the device (x °C) has exceeded the
failure threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.
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Error

Temperature of device (x °C)
exceeded permanent limit (y °C).

Temperature of output board (x °C)
exceeded limit (y °C).

Temperature sensor of controller
board failed.

Temperature sensor of output
board failed.

Trigger period (x, triggers counted
y) is not in acceptable range
compared to previous trigger
period (2).

Trigger signal missing. Current
trigger period (triggers counted x)
is out of the specified range related
to the previous trigger period.
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Description

The temperature of the device (x °C) has exceeded the
warning threshold limit (y °C) for more than two minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature of output board (x °C) exceeded limit
(y °C). Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor of controller board failed. Restart
the device. If the error occurs again after restarting the
device, please contact MOTORTECH.

The temperature sensor of output board failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.

The trigger period (x, triggers counted y) is not in
acceptable range compared to previous trigger period (z).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 96). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 159.

The trigger signal is missing. Current trigger period
(triggers counted x) is out of the specified range compared
to the previous trigger period. Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 96). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 159.
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8.12.7 Runtime Data — Diagnostics

M MICT - Runtime Data - O X

L2 Ok

Overview  Timing  Igniton  BankA  States  Messagelog  Diagnostics  Temperatures  Information

CAN State
) Error Active ) Error Passive & Bus OF
Voltages
Supply Voltage [V]
0 10 20 30 0

Pickup Input 1 Pre-Trigger [V]

N ee———
Q 2 4 6 H 10

Pickup Input 2 Pre-Trigger [V]
=
0 2 4 & 8 10

Pickup Input 3 Pre-Trigger [V]

- ]

] H 4 6 8 10

Aux Pickup Supply Voltage [V]
-
0 s 10 15 20 25

Aux Analog Input Supply Voltage [V]
|

L § 10 15 20 25

Power

power output (] | EHE

D COM4 1D MICA 4¢1.08 (1.5.1 (00002801)) Lifetimne: S0:40:50.965 .

The following information is provided:

— CAN State
The status display indicates the current error handling status of the device for the CAN bus
communication:

— Error Active
The device is in normal state of bus communication. If an error occurs in communication,
the device sends an active error flag.

— Error Passive
After a defined number of errors in bus communication, the device changes to state Error
Passive. If another error occurs, the device sends a passive error flag.

— Bus Off
The device is disconnected from the CAN bus due to error accumulations in bus
communication.
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— Voltages

— Supply Voltage
Current voltage supply of the controller board.

—  Pickup Input Pre-Trigger Voltage
Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups on page 96).
During operation the pre-trigger voltage for passive pickups is increased depending on
the speed, so that the ignition controller is less prone to interferences.

— Aux. Pickup Supply Voltage
Current auxiliary supply voltage of the pickups (refer to Engine — Pickups on page 96)

— Aux. Analog Input Supply Voltage
Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on
page 100)

- Power

— Power Output
Current power output

8.12.8 Runtime Data — Temperatures

M MICT - Runtime Data - [m] X

= ) ) G
SHEHA G
Overview Timing Ignition Bank A States Message Log Diagnostics ~ Temperatures Information

Controller Board

CurremTemp[’C]- ____ I
0 0 50 100 150
MinTamp['C]- I
%0 0 50 100 150
MaxTemp[‘C]- | I
0 0 50 100 150
Output Board

Current Temp (C] | EH] w——
T T T
S0 0 50 100 150
Min Temp (°C) |EEY ——
T T T
S0 s 100 1%
MaxTemp[“G]- ____ I
r—rT 1771711
-50 L] 50 100 150

@) COM4 1D MIC4 4x1.08 (1.5.1 [00002801]) Lifetime: 50:40:50.965 .
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In the window you receive an overview of the temperatures of the controller board and the output

board. The maximum and minimum values are reset at each new start of the ignition controller.
The following information is provided:
— Controller Board

- Current Temp.
Current temperature of the controller board

- Min. Temp.
Minimum measured temperature of the controller board

- Max. Temp.
Maximum measured temperature of the controller board
—  Output Board

- Current Temp.
Current temperature of the output board

- Min. Temp.
Minimum temperature measured on the output board

- Max. Temp.
Maximum temperature measured on the output board

Rev. 01/2026
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8.12.9 Runtime Data — Information

M MICT - Runtime Data

53

Igniton  BankA  States  Messagelog  Diagnostics  Temperatures = Information

Overview  Timing

Device
Device ID

Arrangement Number

Serial Number

Bootloader Version
Firmware Version

Operating Hours
Controller Board

Serial Number
Hardware Version

Output Board
Serial Number
Hardware Version
Clock

Date and Time

B
=]

B g3

MIC4 4%1.08 (1.5.1 (0000a801))
421.08.C0Q0-000-AA5
01078469

0.26.2.20138
1.12.0.40630

50:16:41.981

3100008637
1.4.0.19856

9106554952
1.3.0.12976

Wednesday, July 14, 2021 10:41:54 AM UTC

QD coma 1D MIC4 4x1.08 (1.5.1 [00002801]) Lifetime: 50:16:41.981

In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department as a PDF

file by email. For fast support, we will then immediately have all required information.
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8.13 Log
Click on the symbol to open the window Log. This window is only available to
ﬁ users with authorization for the access level Advanced Service.
8 MICT - Log - o X
B Automatic scroling Log level: dsbug -
Write log to fla:  nja Selact file

23.06.21 10:15 /src/runtime_data/runtime_data.cpp (15%6€) Rebuild firing point list.

23.06.21 10:17 /src/pickup_signal_handler/pickup_signal_handler.cpp (437) select inpucs:
23.06.21 10:17 /src/pickup_signal_handler/pickup_signal_handler.cpp (437) select inpucs:
23.06.21 10:17 /sre/pickup signal handler/pickup_signal handler.cpp (437) select inputs:

-1
oo
o oo

The window Log serves to assist MOTORTECH with error diagnosis.

— Automatic scrolling
If the function is active, the display area focuses on the latest message.

- Log level
The selection of the log level is specified by MOTORTECH if needed.

—  Write log to file
The checkbox activates or deactivates the saving of logged data to a selected file. If the
function is deactivated, the logged data is only displayed.

— Selectfile
With this button, you can select a file to which you want to save the logged data.
If you are prompted to create a log file in the event of a service case, proceed as follows:
1. Open the window Log via the toolbar or the menu bar.
2. Select a path with the Select file button and enter the file name for the log file.
» If the file does not yet exist, it is automatically created with the extension ./og.

Activate the checkbox Write log to file.
Select the level specified by MOTORTECH from the list Log level.
5. Leave the window open.

» The log messages are logged both in the window and in the selected file.
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|

NOTICE

Date and time of ignition controller

The date and time can be individually configured for each ignition
controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur
between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time
in the menu via Device -> Set date and time.

8.14 Runtime Ajustments

140

P

|

NOTICE

Click on the symbol to open the window Runtime Adjustments. This window is only

/a available to users with authorizations starting at access level Service.

Runtime adjustments are implemented directly

All runtime adjustments are implemented directly without requiring the
input to be confirmed and are retained even in the case of an MIC4
restart.

Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.
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8.14.1 Runtime Adjustments — Reset
M MIcT - Runtime Adjustments - [m] X
Resat Timing Energy Secondary Voltage Cabbration Secondary Shert Calibration

reset rcran) [EEEII RET

@osaov | € o.aov P oarer | Posrer

@ COMS D MIC44x1.08(1.5.1[0000a801))

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

- 0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET
in 0.5° increments to advance or retard
Changes are implemented immediately and stored in the configuration located in the device.

If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups on page 96).
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8.14.2 Runtime Adjustments — Timing
B! MICT - Runtime Adjustments - [m] x
Reset Timing Energy Secondary Voltage Cakbration Secondary Shert Calibration
Timing Correction [SCRANK] - ADV
Glabal Temng pomnt (-crared] [ ~ov

&osmov € oaov P oarer Posrer

@ COMS D MIC44x1.08(1.5.1[0000a801))

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded) while
the device is being operated. The correction is made with the buttons:

- 0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET

in 0.5° increments to advance or retard
The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 101) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in place if
the device is restarted. NOTICE: The configuration defined in the device is not changed.
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8 Settings via the MICT

8.14.3 Runtime Adjustments — Energy
B! MICT - Runtime Adjustments — O x

Reset Timing Energy Secondary Voltage Cabbration Secondary Shert Calibration

Schedule A
Sperk ouration (5] | EIEN
&-10us &€ -1ps Prtps | P rops
spark ntensity (ma) | SR
&-10ma € -1ma Drima | Priom
Schedule 8
Sparkuu-amnms]-
& -10ps € -1ps > ips | o
saarklnwws«ty[mt\]-
&-10oma € -1ma Drima | Priom

@ COMS D MIC4.4x1.08 (1.5.1[0000a801)) .

The energy settings can be separately adjusted for both schedules. Changes are implemented
immediately and stored in the configuration located in the device.

Spark Duration
- +/-1pus

lengthen or shorten in microsecond increments
- +/-10ps

lengthen or shorten in 10 ys increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10mA

increase or reduce in 10 mA increments
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8.14.4 Runtime Adjustments — Secondary Voltage Calibration
¥ MICT - Runtime Adjustments - O x

Reset Timing Energy Secondary Voltage Calibration Secondary Short Calibration

All Outputs

& 05 € -0.1 Reset ® 0 W +os
Output Offeet 0.5 0.1 +0.1 +0.5
AL E « € 2> »
A2 Hl « < ¥ »
A3 N <« € > »
A4 B « < > »
as HE « € > »
a6 i « <€ » »
a7 EHE « € > »
A3 <« € > »

@ COMS  ID MICA 4x1.08 (1.5.1[0000a801])
The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be set for the secondary voltage estimation for every output
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This
allows, for instance, different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made globally or individually for each cylinder using the respective buttons.
The value range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.

Changes are implemented immediately and stored in the configuration located in the device.
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8.14.5 Runtime Adjustments — Secondary Short Calibration
¥ MICT - Runtime Adjustments - O x

Reset Timing Energy Secondary Voltage Cabbration Secondary Short Calibration

Secondary Short Enable Voltage

Secondary Short Encbe voltage 1] ] EEE e
Secondary Short Sensitivity

Secondiey Shct Sarsthty PEEE

b o1 b 0.01 o 0001 | b o.0001

= 0,1 == 0.01 = 0.001 = 0.0001

@ COMS D MIC4.4x1.08 (1.5.1[0000a801)) .

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted.
Changes are implemented immediately and stored in the configuration located in the device.

Secondary Short Enable Voltage [kV]
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

— The secondary short detection is always activated at a value of 0 kV.
— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.
— The sensitivity is low at a value of 1.02.

Adjust the sensitivity of the short-circuit monitoring

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity
must be set to 1.02.

If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity
must be set to 0.98.

EXAMPLE

Rev. 01/2026

145



8 Settings via the MICT

8.15 Cyllnder Individual Offsets

Click on the symbol to open the window Cylinder Individual Offsets. This window is
only available to users with authorizations starting at access level Service.

B! MICT - Cylinder Individual Offsets - a X
B Offset [ 0.5 3 0.1 0.1 o 0.5

M R = &« € > »

A2 - ADYV « € > »

A3 - RET « € > »

A4 R <= «® <€ » »

As I = « € b4 »

A I « € » »

a7 I = &« € b2 »

P R = « € ¥ »

@ COMS 1D MIC4 4x1.08 (1.5.1 [0000a801))

The cylinder individual offset can be applied to the position of the timing point while the controller
is being operated. Offset via keys:

- 0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET
in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 101.

Immediate execution of the changes

i Please note that changes made to the timing point are executed

immediately at the next firing of the corresponding cylinder. The
maximum performed change per cycle is however limited by the
NOTICE corresponding setting in the configuration. For this read Timing —
Miscellaneous on page 104.

Save changes automatically
-4 Please remember that changes to the ignition timing are saved

1 automatically.

NOTICE
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8.16 Schedule Curve
Click on the symbol to open the window Schedule.

8.16.1 Schedule Curve — Simulation

M MICT - Schedule - a b4
Simulation 15.0 BTDC
Simulation
Fotentiometar
W0
2 s [700%  [& ]
'.J R o 10.0 BTDC
0 100
Analog Current Input ;.
10 Z
-
VAR B
g
- ST
o
£
E
Analog Voltage Input: (s

I EN 0 N O
J } /,// :
0.0 ATDC B

Schedule

© Schedule A Schedule B

Timing Point

R 5.0 ATDC = : : ; : .

0 500 1,000 1,500 2,000 2,500
Speed [RPM]

| = MnTmng — MaxTiming — Min Speed Curve Timing — Max Speed Curve Tming — Speed Curve 4 Current speed

@ COMS D MIC4 4x1.08 (1.5.1 [00002801]) .

The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs over the speed range. With the optional input fields, you can switch between schedule
A and B. Changes made by turning the control buttons or entering the desired values are
displayed simultaneously.

— Simulation
The simulation is activated or disabled using the checkbox.

— Potentiometer
Simulation of the potentiometer

— Control button for adjustments between 0 % and 100 %
—  Field for manual input of the desired value in %
— Displays the value in °crankshaft by which the timing is offset
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— Analog Current Input
Simulation of the analog current input

— Control button for adjustments between the configured values (e.g. 0 mA and 20 mA)
—  Field for manual input of the desired value in mA
— Displays the value in °crankshaft by which the timing is offset
— Analog Voltage Input
Simulation of the analog voltage input
— Control button for adjustments between the configured values (e.g. 0 V and 10 V)
— Field for manual input of the desired value in V
— Displays the value in °crankshaft by which the timing is offset
— Schedule A/B
Select between Schedule A and B
— Timing Point
Displays the global ignition timing as it changes during the simulation.

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as ® in the diagram.
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8.16.2 Schedule Curve — Runtime Values
If the checkbox Simulation is unchecked, the Schedule curve window switches to the current
runtime data.

M MICT - Schedule - a X

(O simutation 15.0 BTDC
Runtime Values — <
Schedule

Schedule: A
Potentiometer

N I [EEREAMEES
Analog Current Input 10.0 BTDC = . ¥

I -~ [ "

Analog Voltage Input
I -
Spaad

I

Timing Point

I o

5.0 BTDC

Timing [°CRANK]

0.0 ATDC

5.0 ATDC

— —_— —_— —_—— : — . .
0 500 1,000 1,500 2,000 2,500
Speed [RPM]

— MinTiming — Max Timing — Min Speed Curve Timing — Max Speed Curve Tming — Speed Curve @ Current speed

@ COMS 1D MIC4 4x1.08 (1.5.1 [0000a801])

The following information is provided:
— Schedule
Displays the currently selected schedule.

— Left column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the new calculated adjustment values for the potentiometer, current and voltage
input.

— Right column: Potentiometer, Analog Current Input, Analog Voltage Input
Display of values supplied by the ignition controller for the potentiometer, current and voltage
input.

- Speed
Display of the current speed

— Timing Point
Displays the current global ignition timing.
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8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the
database as follows:

Tools -> Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the Coils
window.

Symbol Function

Stores the information on the selected ignition coil in a format that is appropriate
for configuring the MIC4 via fieldbus.
Prints the selected coil data set.

Prints the selected coil data set as PDF file.

Opens the print preview.

Coils
— Device

Select an ignition controller.
- Call

Select an ignition coil.

Select the correct ignition controller

i The ignition coil data depends on the ignition controller used. Always

select the ignition controller for which you are using the coils in order to
obtain the correct data.

NOTICE
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8.17.1 General

M MICT - Coils

Eile

HyHHA

Coils

Device: MIC4

Col: [ 06.50.003

06.50.065
06.50.100
06.50.102
06.50.104
06.50.105
06.50.107
06.50.108
06.50.112
06.50.113
06.50.145
06.50.146
06.50.147
06.50.148
06.50.155
06.50.156
06.50.157
06.50.158
06.50.162
06.50.165
06.50.300
06.50.301
93.09.150
95.08.003
95.08.040-6
95.08.050-14.5
95.08.222-12
95.08.222-6
95.09.005
95.09.024-11
95.09.050-6
95.09.060-10

Details
The following information is provided:

Name
Coil name

Coil Type ID

General  Min, Energy Limit Curve
Detais
Name: 06.50.104

Col Type 1d: 6
Data Version: 1

Secondary diagnostics avalable if max. breakdown voltage is set i range 38 kV to 47 kv. Additonaly it s required
that the energy limit i set sufficently high according to the min. energy fmit curve.

Coil Parametars

Parameter Min. Max.
Max. Breakdown Voltage [kv] 19 47
Spark Intensity [ma] 32 190
Secondary Voltage Estimation Cabbration 5 5
Secondary Short Sensitivity 0.98 102

Used to clearly identify the ignition coil

Data Version

Shows data version of the ignition coil selected in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the view
Ignition (refer to Runtime Data — Ignition on page 118). The Automatic Online Update should be
activated to ensure that the coil database always has the latest data sets. Additional
information on the online update is provided in the section Online Update Settings on page 76.

Illustration of the ignition coil

Information on the conditions under which a secondary diagnosis is possible using the

displayed ignition coil.
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Coil Parameters
The following information is provided:

152

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The maximum
breakdown voltage is configured in the view Timing — Schedule A/B — Energy (refer to Timing
— Schedule A/B - Energy on page 103).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the view Timing — Schedule A/B — Energy (refer to Timing — Schedule A/B -
Energy on page 103).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The
calibration of the secondary voltage calibration takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 94) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Voltage Calibration on page 144).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 94) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Short Calibration on page 145).
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8.17.2 Min. Energy Limit Curve

M MICT - Coils - o X

Eile

: = (= (=g
o 55
e General Min. Energy Limit Curve
Device: MIC4 - Min. Energy Linit Curve

Col: [ 06.50.003 300
06.50.065 .
0650100
06.50.102 4
06.50.104 ]
06.50.105 250
0650107
06.50.108
0650112
06.50.113
06.50.145
06.50.146
06.50.147
0650148
06.50.155
06.50.156
06.50.157
06.50.158

06.50.162

06.50.165 ] /
0650300

0650301 100
93.09.150 1
95.08.003 1
95.08.040-6 1
95.08.050-14.5
95.08.222-12 50
95.08.222-5 ! ! ! ) 7 :

95.00.005 15 20 25 30 35 40 45 50
95.00.024-11 Max. Breakdown Voltage [kV]

95.09.050-6 | — Min. Energy Limit 1 Min./Max. Limit Sacondary Diagnostics

95.09.060-10

Min. Energy Limit [m3J]

Min. Energy Limit Curve

The curve provides information on the energy in mJ necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the view
Timing — Schedule A/B — Energy (refer to Timing — Schedule A/B — Energy on page 103).

When printing the coil data set, the curve values are also provided as a list.
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9 Operation

9.1 Start-up
Before you start up the MIC4 ignition controller, take note of the following:

Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

Is the wiring of all pickups compliant with the drawings given in this operating manual?

Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter
Determine the Installation Location of the Pickup on page 35)?

Ensure that the data were transferred flawlessly to the controller.

Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

Close the service screw and the service cover after completing the installation and
configuration.

Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
Ensure that the gas valve is closed.

Perform the normal engine start-up process while the gas valve is closed (start only).
Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft. If
the ignition timing does not coincide exactly, change it (see chapter Runtime Data on page 113)
until the optimal setting is reached. If the ignition does not fire, read the instructions in section
Troubleshooting on page 160.

Check all other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

9.2 Shutdown

The ignition controller is shut down by disconnecting it from the power supply.
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9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The
program is provided on the storage device (USB flash drive or CD-ROM supplied).

Install MOTORTECH Flash Tool
Install the MOTORTECH Flash Tool as follows:

1. Start the installation:

— Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine for the
MOTORTECH Flash Tool via Software -> MOTORTECH Flash Tool -> Install MOTORTECH
Flash Tool.

— Directly from the storage device:
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage
device in the subdirectory Installation and for example named as follows: MOTORTECH-
Flash-Tool-0.23.00000-setup.exe.

2. Install the program.
Follow the instructions of the installation routine. Note that the license agreement terms must
be accepted before using the MOTORTECH Flash Tool.

3. If the USB driver is not yet installed, also install it via the menu or directly from the storage
device.
— Viathe menu:
Software -> USB Drivers -> Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers
(e.g. CDM21226_Setup.exe).

» The MOTORTECH Flash Tool is set up. You can now connect your computer to the
ignition controller via the USB interface.

Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

Symbol Menu Function

= File -> Open Opens a firmware file.

File -> Quit Exits the program.
View -> Extended file Fades in/out additional information of the
information view firmware file.
View -> Extended connection Fades in/out additional information and settings
settings of the connection to the device.

Q View -> Reload file Reloads the file information of the selected

1 firmware file.
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Symbol Menu Function

@ Device -> Search devices Restarts the search for connected devices.

%;h Device -> Flash device Starts the update or downgrade process.
]

Settings -> Language Opens the window Select Language in which
you can change the interface language of the
program.

Help -> Help Opens the online help.

Help -> About MOTORTECH Opens detailed information on the program.

Flash Tool

Start Firmware Update

Access control for firmware update

If you have activated the access control for the ignition controller, you
1 need the PIN for the level Master for the firmware update. For more

information read the section Access Control for MIC4 on page 81.
NOTICE

Backup the existing configuration

i Your device's configuration may be lost if the firmware update is not

performed properly. Always backup the existing configuration via the
MICT prior to performing an update. For more information read the
NOTICE section Working with Configurations on page 83.

To start a firmware update, proceed as follows:
1. If an MICT is connected with the ignition controller, disconnect this connection.
2. Start the MOTORTECH Flash Tool on your computer.
» The program is started and automatically checks all ports for connected devices.

3. Inthe Status section under Device, check if your device has been recognized properly.

» If the MOTORTECH Flash Tool does not recognize a device that is connected to your
computer via the USB interface, you can usually still carry out a firmware update. To do
so, observe the instructions in the information windows of the MOTORTECH Flash Tool
for the following steps.

4. Inarea File, select the desired update file using the Select button.

156 Rev. 01/2026



9 Operation

Use the file information displayed to ensure that the update is correct for your device.
Start the update process using the Flash button or using the menu or toolbar.
> Theignition controller is restarted automatically.
> Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.
7. Confirm with Yes to proceed with the update process.
> The update will start.
> A message will confirm that the firmware update was successful.

8. After a successful firmware update, check all configuration data.

Downgrade process

-4 The process for downgrading is largely the same as for updating. You will

1 only be notified that newer firmware is installed on the device.

NOTICE

Help with connection problems

e If a correctly connected device cannot be found during the automatic
1 search, this may, for example, be because too many communication
interfaces are occupied and need to be checked. In this case, an interface
NOTICE can be selected from the drop-down list Port in the area Connection and

therefore specified.

If the desired port is not yet displayed in the list or if the problem persists,
adjusting the connection timeouts may help. The time-out settings are
displayed in the main view by selecting the following entry in the menu
bar: View -> Extended connection settings

Make the following settings:

— Update Request Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
Extending the timeout can be particularly beneficial in the event of
connection problems caused by the computer having many occupied
ports.

— Start Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
Changing the timeout can be particularly beneficial in the event of
connection problems caused by disrupted communication between
the computer and the device.

Rev. 01/2026 157



10 Errors

10.1 Possible Faults
The MIC4 ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

— External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

—  Output Error Detection

— Shut down in the case of a faulty pickup or faulty pickup signals.
- Alarms

— Faulty voltage supply

— External EMI signals

10.2 Causes of Faults

10.2.1 Overspeed

The engine speed has exceeded the set overspeed value. As of firmware version 1.11.00000, an
operating error caused by overspeed is indicated on the device by the status LED flashing four
times (4 times red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 28.

Potential Causes
— Speed controller does not function properly

—  Fuel supply to engine is not optimal.
— Faulty pickup signal

10.2.2 Output Error Detection
An internal failure of the high voltage supply or a defective output switch occurs.

Potential Causes
— Hardware fault on the MIC4

— Defect in the wiring (short circuit or open circuit)

10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential Causes
— Defect in the output wiring

— Ignition coil defective
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10.2.4 Pickup Input Errors

Faulty input signals from the pickups are detected. As of firmware version 1.11.00000, an pickup
input error is indicated on the device by the status LED flashing two times (2 times red/off 250 ms,
750 ms off). Refer to the section LED Functions on page 28.

Potential Causes
— Number of teeth on the flywheel does not match the set number.

— Damage to or uneven running of trigger disc
— Interference in the wiring of the pickup

- Wiring of the pickup incorrect

— Distance of the pickup incorrect

— Dirt on the pickup

Troubleshooting for Possible Causes

You will find information on possible causes of a pickup input error in the windows Runtime Data —
States (see Runtime Data — States on page 120) and Runtime Data — Message Log (see Runtime
Data — Message Log on page 126). When analyzing the messages shown there, please note that
the number of the pickup (e.g. PU2) only names the pickup at which the error or problem was
identified. Hence, this does not mean that this particular pickup also caused the problem. For
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the
problem may only be identified at pickup input PU2.

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to the
documentation on the pickup status bits on the storage device enclosed with the ignition
controller. You can open the file via the menu: Documentation -> More information.

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the
section Pickup Trace on page 79. Compare the signals recorded there with the pickup settings in
your configuration (see Engine — Pickups on page 96).

10.2.5 Faulty Voltage Supply

If the supply voltage falls below the 16.8 V required for safe operation of the ignition controller,
error messages may appear. As of firmware version 1.11.00000, an operating error on the device
caused by insufficient supply voltage is indicated by the status LED flashing five times (5 times
red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 28.

Potential Causes
— The power supply is dimensioned too small.

— The battery is worn out.
— The wiring for the power supply is defective.
— The wiring for the power supply is routed incorrectly.
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10.2.6 Acknowledging Faults
While the engine is in standstill, you have the following options for acknowledging operational
errors:

— Via Acknowledge Operational Error in the MICT

— Acknowledgment of the error via CAN bus or RS485

— By disconnecting the supply voltage

— Hold button PB on the controller longer than three seconds

10.3 Troubleshooting

10.3.1 Running a Self Test

You can run the self test via the MICT to check the order of the wiring and the connection between
the ignition controller outputs and the spark plugs. For this refer to section Self Test on page 77.
From firmware version 1.11.00000, the running self-test is indicated on the device by the status

LED flashing once (1 time orange 250 ms on, 750 ms off). Refer to the section LED Functions on
page 28.

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

10.3.2 Customer Service Information
You can reach us during our business hours by:

Phone: +49 514193990

Email: service@motortech.de (technical support)
sales@motortech.de (all other matters)

10.3.3 Returning Equipment for Repair/Inspection

To return the device for repair and inspection, first consult your MOTORTECH contact person (see
Customer Service Information on page 160). From him you will receive all the information you need
to process your order quickly and smoothly. For return shipment, also observe the instructions in
the section Instructions for Packaging the Equipment on page 161.
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10 Errors

10.3.4 Instructions for Packaging the Equipment
For return shipment, equipment should be packaged as follows:

— Use packaging material that does not damage the equipment surfaces.

— Sturdy packaging of the device
— Use sturdy adhesive film to seal the packaging.
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11 Maintenance

11.1 Maintenance Instructions

Operational safety!

The industrial battery installed on the mainboard is required for reasons
of data integrity and must not be replaced or removed during the service
life of the ignition controller.

Please follow the following maintenance instructions:

— Do not use caustic liquids or steam cleaners for cleaning the device.
— Clean the passive pickups at regular intervals.

— Check the ignition wires at regular intervals.

— Replace the pickups at regular intervals if operating them under elevated temperature
conditions (> +90 °C / > +194 °F).

— Regularly inspect all wires of the ignition system for damage and replace the wires as needed.
— Check all plug-in connections for proper condition.
— Service the spark plugs as per the instructions of the spark plug and engine manufacturers.
— Observe the required tightening torques:
— AllM4 bolts: 0.8 Nm to 1Nm (0.6 Ib-ft to 0.7 Ib-ft)
— PG screw joints: 4.5 Nm to 5 Nm (3.3 Ib-ft to 3.6 Ib-ft)
— Service screw: 2.5 Nm to 3 Nm (1.9 Ib-ft to 2.2 Ib-ft)

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC4 ignition systems, please refer to our current Product
Guide, which is available for download on the Internet at www.motortech.de.
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